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1 CONTEXTE 

1.1 SPÉCIFICATIONS TECHNIQUES 

Ce guide méthodologique fait suite à une demande du MAAF et des DRAAF Rhône-Alpes et Bourgogne dans 

laquelle l’UMR TETIS proposait de définir et mettre en œuvre une méthodologie de détection des coupes rases 

sur deux sylvo-écorégions IFN (G23 : Morvan et Autunois ; G41 : Bordure Nord-Est du Massif Central-Beaujolais) 

à partir d’imagerie satellitaire optique haute résolution, entre 2005 et 2012.  

La méthode est formalisée de manière à répondre aux besoins forestiers exprimés par les services du MAAF, à 

savoir : 

Contenu thématique  Détection des coupes rases entre deux années successives  

Précision géographique  
Surface minimale de détection de 1 Hectare avec une précision planimétrique de 5 à 
10 mètres 

Précision thématique  
Taux d’omission (coupe non détectée) et de commission (fausse détection) de 10% en 
surface 

Système de projection  Lambert 93 

1.2 MUTUALISATION DE L’IMAGERIE SATELLITAIRE 

Cette étude diachronique s’inscrit dans un contexte de mutualisation des données à référence spatiale, 

notamment l’imagerie satellitaire, au niveau national et européen. Il s’agit des initiatives portées par l’Equipex 

Geosud, le pôle Theia (CNES), l’Agence spatiale européenne (ESA) et le programme GMES (Global Monitoring 

for Environment and Security). 

1.2.1 EQUIPEX GEOSUD 

 

Le projet d’Equipex Geosud « Infrastructure d’Information Spatiale sur les Territoires et l’Environnement » a 

pour objectifs d’assurer : 

• L’accès pérenne à l’information spatiale sur les écosystèmes et les territoires par l’acquisition annuelle 

d’une information satellitaire complète et multi-capteurs du territoire national et sa mise à la 

disposition gratuite de la communauté scientifique et de la communauté des acteurs de la gestion de 

l’environnement et des territoires, 

• La mise à disposition de capacités de calcul et d’administration de données adaptées à l’exploitation 

de cette information spatiale (en traitement d’image et en analyse spatiale) ainsi que l’offre de 

formation correspondante, 

• L’appui aux recherches amont sur les méthodes et algorithmes de traitement de l’information spatiale 

(traitement d’image, couplage de données multi-source image et in situ, exploitation de séries 

temporelles, fouille de données image, spatialisation de modèles, traitement en ligne, analyse 

spatiale…), 

• L’appui aux recherches thématiques sur la structure, le fonctionnement et la dynamique des 

écosystèmes et des territoires et sur l’élaboration de stratégies de gestion et de suivi adaptées aux 

politiques publiques, 
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• L’interaction et le partage d’expérience entre la communauté scientifique et la communauté des 

acteurs publics (État et collectivités territoriales) de la gestion de l’environnement et des territoires. 

Le projet s’inscrit à l’interface entre le domaine « Environnement et Société » et le domaine « Sciences et 

Techniques de l’Information et de la Communication » et vise à combler par une stratégie active le fossé actuel 

constaté entre le fort développement des technologies amont d’observation satellitaire de la Terre et leur 

relativement faible utilisation tant par la communauté scientifique que par les acteurs de la gestion de 

l’environnement et des territoires. 

La structure de l’équipement d’excellence s’articule en 3 composantes : 

• L’acquisition de données satellitaires pour le suivi du territoire national et de zones d’intérêt à définir, 

par réception directe (antenne de réception GeoSud) ou acquisition indirecte auprès de fournisseurs. 

Elle inclut l’acquisition annuelle d’une couverture d’été du territoire national à haute résolution 

spatiale (5-20m) permettant de caractériser finement les différents milieux constitutifs d’un territoire, 

les pressions anthropiques sur les écosystèmes et spatialiser les modèles environnementaux et 

territoriaux. 

• Une infrastructure d’administration et diffusion de l’imagerie satellitaire (accès gratuit aux acteurs de 

la communauté scientifique et aux acteurs publics de la gestion sur le portail Web : http://equipex-

geosud.fr/), des capacités de calcul scientifique spécialisé pour le traitement de l’information spatiale 

(notamment son traitement à distance) et un dispositif de formation. 

• Un dispositif de soutien aux recherches méthodologiques sur le traitement de l’information spatiale et 

aux recherches thématiques dans les différents domaines liés à l’environnement et aux territoires. 

Au-delà de l’innovation scientifique dans les approches des sciences de l’environnement et des territoires, un 

enjeu très fort du projet réside dans la mise en réseau des équipes de recherche et des acteurs publics de la 

gestion et dans l’animation du partage d’expérience autour d’une source d’information pleinement mutualisée 

et accessible à tous. 

1.2.2 PÔLE THEIA 

 

Le Pôle Thématique Surfaces Continentales THEIA  (http://www.theia-land.fr/) est une structure nationale 

inter-organismes
2
 ayant pour vocation de faciliter l’usage des images issues de l’observation des surfaces 

continentales depuis l’espace. À cette fin THEIA met à disposition de la communauté scientifique nationale et 
internationale, et des politiques publiques de suivi et de gestion des ressources environnementales, une vaste 
panoplie d’images à différentes échelles, des méthodes et des services liés à l'observation depuis l'espace des 
surfaces continentales. 

Son objectif est de faciliter la mesure de l'impact des pressions anthropiques et du climat sur les écosystèmes 
et les territoires, observer, quantifier et modéliser les cycles de l'eau et du carbone, de suivre les évolutions des 
sociétés et de leurs activités, notamment de leurs pratiques urbaines, agricoles et forestières, et de 
comprendre les dynamiques de la biodiversité. 

Les produits et services offerts par THEIA, de qualité contrôlée, couvrent de larges territoires et de longues 
périodes : couvertures satellitaires annuelles du territoire national, séries temporelles de réflectance de surface 
à haute ou très haute résolution, séries temporelles de produits bio-géophysiques à l'échelle globale 

                                                                 
2
 CEA, Cirad, CNES, IGN, INRA, CNRS, IRD, Irstea, Météo France. 
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(biomasse, hauteurs d'eau, humidité de surface, etc.), outils d'aide à la visualisation et au traitement des 
données, méthodes et algorithmes de traitement et des procédures de validation. 

THEIA se développe en capitalisant sur des projets en cours de réalisation, en voie d’achèvement, ou terminés. 
Même si ces différents projets se déroulent dans des cadres de partenariat et de temps assez différents, ils ont 
en commun de correspondre à des attentes exprimées de longue date par la communauté scientifique 
nationale. Leurs produits sont distribués dans un cadre unifié au travers du portail de THEIA. 

Les projets fondateurs de THEIA sont l'Equipex Geosud, le Géoportail et Muscate. En outre, THEIA a vocation à 
fédérer l'ensemble des initiatives présentes et passées ayant un caractère national et visant les acteurs publics 
nationaux au sens large. 

1.2.3 GMES ET COMPOSANTE SPATIALE 

 

Le programme européen de surveillance de la Terre Copernicus (ou Global Monitoring for Environment and 

Security – GMES) est une initiative conjointe de l’Agence spatiale européenne (ESA) et de l’Union européenne 

qui vise à doter l’Europe d’une capacité opérationnelle et autonome d’Observation de la Terre (OT). L’objectif 

est de rationaliser l’utilisation des données relatives à l’environnement et à la sécurité issues de sources 

multiples, afin de disposer d’informations et de services fiables. En d’autres termes, GMES permettra de 

rassembler l’ensemble des données obtenues à partir de missions satellitaires, dont celles de l’ESA, et 

d’instruments de mesure in situ et ce, afin de surveiller l’état de notre planète. 

Le GMES regroupe trois composantes : 

• La composante spatiale, 

• La composante in-situ, 

• La composante des services à l’utilisateur. 

Le GMES est articulé autour de trois niveaux de fonctions : l’acquisition et la mise à disposition des mesures 

spatiales et in situ, le traitement « générique » et la diffusion d’informations et de services de base pour les 

différentes thématiques traitées (Core Service) ainsi que des traitements à la demande dits services « Aval » 

(Downstream Service). 

En parallèle, l’ESA conduit la mission d’imagerie optique Sentinel-2 comprenant un couple de satellites qui 

délivrera une couverture systématique de toutes les terres avec une répétitivité de 5 jours minimum. Sentinel-

2 offre un fauchée de 290km avec une résolution spatiale comprise entre 10 et 60m en fonction des bandes 

spectrales, et embarque treize instruments à canal optique (du proche infrarouge-visible à l’infrarouge-ondes 

courtes). Le premier satellite devrait être lancé à l’horizon 2015. Ces données bénéficieront aux institutions 

nationales et européennes chargées, par exemple, de l’aménagement du territoire, de l’agriculture et de la 

sylviculture. À ce jour, les modalités de diffusion de ces images ne sont pas clairement définies. 

1.2.4 COUVERTURES SATELLITAIRES DISPONIBLES 

Le projet Geosud, le Pôle Theia et la composante spatiale du GMES permettent d’accéder aujourd’hui à 

plusieurs couvertures satellitaires multispectrales, à moyenne et haute résolution spatiale. Bien que les 

licences d’exploitation soient quelque peu différentes, l’ensemble de ces données ont en commun la possibilité 

d’être téléchargées et utilisées gratuitement par les institutions publiques françaises. Le Tableau 1 détaille les 

caractéristiques des couvertures satellitaires existantes, classées par ordre chronologique :  
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Tableau 1. Couvertures satellitaires mises à disposition par les programmes GMES et GeoSud 

Date Nom Programme Capteur 

2014 Couverture été 2014 Theia/Geosud 
SPOT 6 
SPOT 7 

2013 Couverture 2013 en réflectance de surface Theia Landsat 8 

2013 Couverture été 2013 Theia/Geosud 
SPOT 5 
SPOT 6 

2011-2012 
Optical HR PanEU coverages 2011/2012 
DWH_MG2_CORE_01 

GMES/Geosud 
IRS-P6 Resourcesat-1 
SPOT 4, SPOT 5 
RapidEye 

2011 Couverture hiver/été 2011 GMES/Geosud RapidEye 

2010 Couverture été 2010 Geosud Rapideye 

2009 (± 1 an) 
European wall-to-wall coverage 2009 
DAP_MG2-3_01 

GMES 
ALOS 
IRS-P6 Recourcesat-1 
SPOT 4, SPOT 5 

2006 (± 1 an) 
European coverages of IMAGE2006 
DAP_MG2_08 

GMES 
IRS-P6 Resourcesat-1 
SPOT 4, SPOT 5 

2005 Couverture été 2005 Geosud SPOT 5 

La méthode de détection des coupes rases, présentée ci-après, est originale car transposable sur différents 

types d’images satellitaires (cf. Tableau 2) présentant des caractéristiques différentes, notamment en termes 

de résolutions spatiale et spectrale. Pour ce faire, les bandes spectrales utilisables sont restreintes au nombre 

de trois : deux bandes dans la partie visible du spectre – le vert, le rouge – et une bande dans le proche 

infrarouge. 

Tableau 2. Caractéristiques des capteurs utilisés 

Capteur Résolution spatiale (m) Résolution spectrale Résolution radiométrique 

IRS-P6 Resourcesat-1 
Panchromatique 
Multispectral 

5.8 
23.5 

Vert 
Rouge 
Proche infrarouge 
Moyen infrarouge 

7 bits 

RapidEye Multispectral 5 

Bleu 
Vert 
Rouge 
Rededge 
Proche infrarouge 

16 bits 

SPOT4 
Panchromatique 
Multispectral 

10 
20  

Vert 
Rouge 
Proche infrarouge 
Moyen infrarouge 

8 bits 

SPOT5 
Panchromatique 
Multispectral 

5 
10 

Vert 
Rouge 
Proche infrarouge 
Moyen infrarouge 

8 bits 

SPOT 6/7 
Panchromatique 
Multispectral 

1.5 
6 

Bleu 
Vert 
Rouge 
Proche infrarouge 

16 bits 

Landsat 8 
Panchromatique 
Multispectral 

15 
30 

Aérosols 
Bleu 
Vert 
Rouge 
Proche infrarouge 
Moyen infrarouge 1 
Moyen infrarouge 2 
Cirrus 

16 bits 
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2 MÉTHODE DE DÉTECTION DES COUPES RASES – ÉLÉMENTS THÉORIQUES 

La cartographie des coupes rases repose sur une méthode de détection des changements à partir de deux 

images satellitaires optiques, acquises en été à une ou plusieurs années d’intervalle (cf. Présentation Tetis au 

COPIL du 23 avril 2012, p.viii). La procédure d’extraction peut être scindée en deux grandes étapes :  

• une phase de prétraitement ou de mise en conformité des données pour assurer la comparabilité en 

termes de géométrie et de radiométrie,  

• une phase de détection et de classification des changements pour aboutir à la cartographie des 

coupes rases.  

La chaîne de traitements est présentée en Figure 1. Les différentes étapes de ces traitements sont ensuite 

décrites en détail. 

 

Figure 1. Étapes du processus d'extraction des coupes rases  

2.1 PRÉTRAITEMENTS DES DONNÉES SATELLITAIRES 

Le prétraitement des données vise à rendre comparable les images satellitaires issues des couvertures multi-

capteurs Geosud, Theia et GMES. Il s’agit dans un premier temps d’obtenir des produits géométriquement 

superposables et restitués dans un référentiel connu, ici la projection Lambert 93 RGF93. La transformation des 

valeurs de pixels (comptes numériques) en réflectance dite TOA (Top of Atmosphere) permet de normaliser les 

images quant à leur composante liée à la variation de l’éclairement solaire. 

Acquisition

• Acquisition des données satellitaires

• Acquisition des données annexes (vecteurs forêt, etc.)

Correction

• Corrections géométriques/planimétriques

• Passage en réflectance TOA

• Normalisation relative inter-images (optionnel)

Détection

• Calcul des indices de végétation NDVI

• Différence des NDVI

• Détection des changements

Classification

• Classification des changements détectés

• Extraction des coupes rases

• Différenciation coupes rases anciennes/récentes, feuillus/résineux

Mosaïque

• Calibration relative (optionnel)

• Fusion des vecteurs des coupes rases

Contrôle

• Calcul des matrices de confusion

• Calcul du coefficient de Kappa

• Analyse
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2.1.1 PRÉTRAITEMENTS GÉOMÉTRIQUES 

Lors de l’acquisition, une image satellitaire subit un certain nombre de déformations géométriques qui peuvent 

être regroupées en deux catégories : 

• Les déformations liées à la « prise de vue » (Figure 2), causées par l’instabilité du satellite (roulis, 

tangage, lacet), par des aberrations du capteur ou bien encore par l’angle d’acquisition. La 

connaissance du fonctionnement du capteur et l’utilisation des paramètres de vols permettent de 

corriger en partie ces erreurs.  

  

Figure 2. Mouvements du satellite et déformations occasionnées sur les images 

• Les déformations liées à la courbure et à la rotation de la Terre ainsi qu’au relief (Figure 3), plus 

complexes à modéliser.  

 

Le point géodésique P0 correspond 
à la géolocalisation fournie dans 
une image « brute ». Le point 
géodésique P1 est la position réelle 
de la mesure. L’orthorectification 
de l’image consiste à corriger cette 
erreur. 

Figure 3. Erreurs géométriques liées au relief et à la courbure terrestre 

Pour la plupart des couvertures satellitaires mises à disposition par les programmes GMES, Theia et Geosud, il 

n’est pas nécessaire d’appliquer des prétraitements géométriques. Excepté la couverture 2005 de Geosud 

(livrée pour le moment à l’état brut), l’ensemble des données est orthorectifié. Les couvertures GMES 

requièrent cependant une transformation dans le système de projection Lambert 93. 

2.1.2 PRÉTRAITEMENTS RADIOMÉTRIQUES 

Les prétraitements radiométriques consistent à transformer les comptes numériques (CN) – codés entre 8 (256 

valeurs) et 16 bits (65536 valeurs) selon les images – en valeurs de réflectance (%). Dans cette méthode, seule 

la réflectance exo-atmosphérique (Top of Atmosphere [TOA] en anglais) est décrite. 

Cette étape tient compte de plusieurs paramètres de calibration associés au capteur et à la date d’acquisition 

(l’éclairement solaire n’étant pas le même selon la saison), notamment : 

1. les coefficients de calibration absolue de gain et d’offset, 

2. l’angle zénithal solaire, 

3. l’irradiance solaire. 
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2.1.2.1 CALIBRATION EN LUMINANCE 

Afin d’obtenir des mesures physiques indépendantes des caractéristiques du radiomètre imageur, les comptes 

numériques sont d’abord convertis en luminance. Par exemple,  

• pour les satellites SPOT, la luminance L
k

TOA (W.m
-2

.sr
-1

.µm
-1

) est associée au compte numérique X
k
 par 

la relation (1) suivante : 

����
� =

��

��
+ 
�    (1) 

où A
k
 est le coefficient de calibration absolue (gain) pour la bande k ; B

k
 le biais de calibration absolue. 

Ces informations sont fournies dans la métadonnée DIMAP de l’image SPOT. 

• Pour les satellites RapidEye, la luminance L
k

TOA (W.m
-2

.sr
-1

.µm
-1

) est associée au compte numérique X
k
 

par la relation (2) suivante : 

����
� = ��. 
�   (2) 

où C
k
 est le facteur de correction radiométrique pour la bande k, quasi égal à 0,01. Ces informations 

sont fournies dans la métadonnée de l’image RapidEye. 

• Pour le satellite IRS-P6, la luminance L
k

TOA (W.m
-2

.sr
-1

.µm
-1

) est associée au compte numérique X
k
 par la 

relation (3) suivante : 

����
� =

	��

����
� . (���� − ����) + ����    (3) 

où X
k

max est la valeur maximale de la bande k (255 pour les produits corrigés LISS-3 et LISS-4), Lmax et 

Lmin sont les valeurs de luminance maximum et minimum de la bande k, et correspondent 

respectivement au biais et au gain. Ces informations sont fournies dans la métadonnée de l’image IRS. 

• Pour le satellite Landsat 8, la luminance L
k

TOA (W.m
-2

.sr
-1

.µm
-1

) est associée au compte numérique X
k
 

par la relation (4) suivante : 

����
� = ��

�. �� + ��
�   (4) 

où M
k

L est le facteur multiplicatif pour la bande k ; A
k
L le facteur additif pour la bande k. Ces 

informations sont fournies dans la métadonnée MTL de l’image Landsat. 

2.1.2.2 CALIBRATION EN RÉFLECTANCE TOA 

La luminance L
k

TOA est ensuite normalisée par rapport au flux solaire incident exo-atmosphérique afin d’obtenir 

la réflectance TOA ρ
k

TOA (comprise entre 0 et 1), calculée comme suit : 

����
� =

�.�� !
� ."#

$%&�'
�.()*	+'

         (5) 

où d est la distance moyenne entre la Terre et le Soleil en unité astronomique (UA), eSun
k

s l’irradiance 

solaire exo-atmosphérique moyenne (ou luminance équivalente solaire), θs l’angle zénithal solaire. Les 

deux derniers paramètres sont donnés dans les métadonnées des images. 
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La distance moyenne entre la Terre et le Soleil est calculée à l’aide de l’équation suivante, avec x dans cos(x) en 

degrés : 

, = 1 − 0,01674. 345	(0,9856. (9: − 4).
�

;<=
)     (6) 

où JD représente le Jour Julien (nombre de jours écoulés depuis le 1
er

 janvier de l’année étudiée).  

Une approximation de la distance peut être retrouvée dans le Tableau 3 présenté ci-dessous: 

Tableau 3. Distance Terre-Soleil (UA) en fonction du jour Julien. 

JD d JD d JD d JD d JD d 

1 0,9833 80 0,9956 160 1,0150 240 1,0102 320 0,9889 
10 0,9833 90 0,9985 170 1,0161 250 1,0077 330 0,9869 
20 0,9839 100 1,0013 180 1,0166 260 1,0051 340 0,9853 
30 0,9849 110 1,0042 190 1,0167 270 1,0023 350 0,9842 
40 0,9864 120 1,0069 200 1,0163 280 0,9994 360 0,9835 
50 0,9882 130 1,0094 210 1,0154 290 0,9966 365 0,9833 
60 0,9904 140 1,0116 220 1,0141 300 0,9938   
70 0,9929 150 1,0135 230 1,0123 310 0,9912   

N.B. Pour simplifier la procédure transposée sous QGis, la distance d peut être considérée comme étant une 

constante égale à 1 quelle que soit la date d’acquisition. 

Pour Landsat 8, l’irradiance solaire exo-atmosphérique n’est pas nécessaire. L’instrument OLI du satellite se 

base sur deux méthodes de calibration en luminance et réflectance développées par le NIST (National Institute 

of Standards and Technology). Par conséquent, l’expression du passage en réflectance TOA ρ
k

TOA diffère 

légèrement : 

����
� =

>?
�.��@�?

�

()*	+'
        (7) 

Où M
k

ρ est le facteur multiplicatif pour la bande k, A
k

ρ le facteur additif pour la bande k et θs l’angle 

zénithal solaire. Les trois paramètres sont donnés dans les métadonnées des images. 

2.1.2.3 PERSPECTIVES THEIA ET MUSCATE 

Les prétraitements radiométriques présentés ici ne seront bientôt plus nécessaires, du moins pour certains jeux 
de données satellitaires. En effet, au sein de Theia, le CNES met en place, avec le concours du laboratoire 
Cesbio, un atelier de production MUlti Satellite, multi-CApteurs, pour des données multi-TEmporelles 
(Muscate). Cet atelier a pour but de proposer aux utilisateurs des produits prêts à l’emploi issus de séries 
temporelles d’images acquises sur de grands territoires. Les laboratoires de recherche et les institutions 
publiques françaises bénéficieront ainsi de données corrigées et distribuées, dans la mesure du possible, 
gratuitement par l’intermédiaire du portail Theia. L'atelier Muscate existe déjà sous la forme d’un prototype 
capable de gérer les données des satellites Landsat, SPOT, Formosat-2, Venµs et Sentinel-2, à partir de chaînes 
développées au CNES pour le traitement géométrique, et au Cesbio pour la détection des nuages et la 
correction des effets atmosphériques. 

En attendant le lancement de la constellation Sentinel-2, fer de lance de cet atelier, Muscate a d’ores et déjà 
démontré sa capacité opérationnelle en produisant les données issues de l’expérience SPOT 4 (Take 5) d’une 
part, les images Landsat 8 (http://spirit.cnes.fr/resto/Landsat) acquises sur la France entre avril et décembre 
2013 d’autre part. 
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Les produits (cf. Figure 4) fournis par Muscate sont les suivants : 

• Niveau 1C : données ortho-rectifiées en réflectance au sommet de l’atmosphère (TOA) 

• Niveau 2A : données ortho-rectifiées en réflectance de surface après correction atmosphérique,  avec 
un masque des nuages et de leurs ombres, ainsi qu’un masque des surfaces d’eau et de neige. 

• Niveau 3A : synthèses mensuelles ou bimensuelles de réflectances de surface, constituées de la 
moyenne pondérée des réflectances de surface des pixels non nuageux obtenus au cours de la 
période. Pour le moment, la chaîne de Niveau 3A n’existe que pour le satellite Venµs. 

Niveau 1C Niveau 2A Niveau 3A 

 

Figure 4. Simulations des produits SPOT4 (Take 5) à partir d'images Formosat-2 (source : Theia) 

2.1.3 NORMALISATION RELATIVE INTER-IMAGES (FACULTATIF) 

L’objectif de la normalisation radiométrique relative est de réduire les effets de changements atmosphériques 

entre deux images acquises sur la même zone à une année d’intervalle. Cette étape peut améliorer 

significativement la détection des coupes rases, en particulier lorsque sont comparées des images issues de 

différents capteurs. Cette méthode ne nécessite pas de connaissance des paramètres atmosphériques 

(pression atmosphérique, quantités de gaz, caractéristiques d’aérosols). Son principe est de choisir une image 

de référence ImgREF présentant une couverture nuageuse minimale, un faible pourcentage de pixels saturés, et 

une large dynamique radiométrique. Ce dernier paramètre traduit une atmosphère relativement « pure », avec 

peu d’aérosols, et donc une faible diffusion. En conséquence l’atmosphère a peu modifié les contrastes, les 

pixels clairs (à forte réflectance) ne sont pas assombris, et les pixels foncés (à faible réflectance) ne sont pas 

éclaircis. Les autres images (ImgSRC) sont normalisées par rapport à cette image de référence en inversant les 

régressions linéaires calculées pour chaque bande spectrale : 

����AB)C�
� = �. ����

� + 
       (8) 

Pour déterminer les paramètres A et B, la méthode des cibles invariantes est ici utilisée. Elle consiste à 

sélectionner sur les images des zones dont la réflectance est quasi constante dans le temps. Concrètement, 

l’opérateur digitalise des cibles invariantes (urbain, eau, etc.) sur les parties communes aux deux images ImgREF 

et ImgSRC. Il calcule ensuite, pour tous les canaux, la moyenne des valeurs de pixels inclus dans les polygones 

(statistique zonale). Ces statistiques permettent de construire des nuages de points pour chaque bande 

spectrale avec, en ordonnées les moyennes de l’image de référence ImgREF et en abscisses celles de l’image à 

égaliser ImgSRC. Les équations des droites de régression linéaire sont ainsi déduites (cf. Figure 5). 

Bien que le calcul des droites de régression soit requis uniquement pour les bandes spectrales du rouge et du 

proche infrarouge, il est conseillé de reproduire cette opération sur la bande verte. La correction de ces trois 

canaux autorise la construction de mosaïques en couleurs RGB. 

La normalisation relative inter-images donne des résultats satisfaisants pour corriger une image par rapport à 

une autre. Au-delà de deux images, cette méthode est déconseillée car elle comporte un risque élevé de 

propagations des incertitudes, biaisant de fait la détection des coupes rases. 
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Sélection des invariants  

 

Tables des moyennes 

 

 

Droites de régression 

 
 

                             

Figure 5. Exemple de normalisation relative 

2.2 DÉTECTION DES CHANGEMENTS ET EXTRACTION DES COUPES RASES 

Par définition, une coupe rase est une modification de l’occupation du sol. Il s’agit donc de détecter les 

changements apparus entre deux dates à partir d’images satellitaires, en faisant appel notamment aux indices 

de végétation, puis de qualifier ces changements afin de ne retenir que les parcelles forestières qui sont 

passées d’un état boisé à un état sol nu. 

2.2.1 DÉTECTION DES CHANGEMENTS PAR DIFFÉRENCE DES NDVI 

La détection des changements entre deux années utilise la différence des indices de végétation NDVI. Cette 

approche a l’avantage de traiter des données normalisées, facilitant de fait les comparaisons dans le temps. 

2.2.1.1 INDICE DE VÉGÉTATION NORMALISÉ NDVI 

L’indice de végétation normalisé (NDVI) permet d’observer et d’analyser la 

couverture végétale sur les images de télédétection. Cet indice traduit la 

signature spectrale très caractéristique de la végétation active (cf. Figure 6). En 

effet, dans la bande spectrale du visible, et en particulier dans le rouge (0.6 à 

0.7µm), la végétation absorbe fortement le rayonnement solaire à cause de la 

chlorophylle, mais cet effet cesse dans le proche infrarouge (0.7 à 0.9 µm) où, au 

contraire, la végétation réfléchit fortement. Comme les sols nus ont une courbe 

de réflectance qui monte légèrement entre le rouge et le proche infrarouge, la 

distinction entre un sol nu et un sol couvert ne pose généralement aucun 

problème. 

L’équation du NDVI est la suivante: 

D:EF =
G� !
HIJ AG� !

JKLMN

G� !
HIJ @G

� !
JKLMN        (9) 

où ρTOA
PIR

 est la réflectance de la bande proche infrarouge et ρTOA
Rouge

 celle de la bande rouge.  

Figure 6. Signatures spectrales de 

la végétation et du sol 



[DÉTECTION ET CARTOGRAPHIE DES COUPES RASES] 01 janvier 2015 

 

UMR TETIS - Irstea | Méthode de détection des coupes rases – éléments théoriques 13 

 

Le dénominateur est un facteur de normalisation qui compense partiellement la différence de réflectance de la 

surface liée à la hauteur du soleil ou aux angles de prise de vue des satellites. Par construction, le NDVI est 

compris entre -1 et 1. 

2.2.1.2 DIFFÉRENCE DES NDVI 

La différence ΔNDVI des NDVI calculés pour chacune des deux années traitées, permet de détecter des 

changements. Ses valeurs sont comprises entre -2 et 2.  

OBPQR = D:EFPS −D:EFP;       (10) 

où NDVID1 et NDVID2 sont respectivement les indices de végétation des années n et n+1. 

 

Figure 7. NDVI au dates D1 et D2 et différence des NDVI 

La Figure 7 schématise la différence des NDVI :  

• à l’année n, la forêt est caractérisée par un NDVI élevé de 0.7, à l’intérieur se trouve une parcelle en 

sol nu (ancienne coupe rase) avec un NDVI faible (0.1).  

• à l’année n+1, la parcelle en sol nu est de nouveau végétalisée, son NDVI augmente. Deux parcelles 

ont subi des coupes rases, elles ont un NDVI égal à 0.1 et 0.2. 

• la différence des deux couches NDVI (NDVID2 - NDVID1) permet d’identifier trois types d’évolution : 

a. Les zones ayant peu ou pas changé ont des valeurs voisines de 0, 

b. Les zones passées de sol nu à végétation ont des valeurs positives, significativement 

différentes de 0, avec un maximum de 2, 

c. Les zones passées de végétation à sol nu ont des valeurs négatives, significativement 

différentes de 0, avec un minimum de -2. 

2.2.2 APPLICATION DE MASQUES 

Pour simplifier la détection des coupes rases et minimiser les risques de confusion, il est recommandé 

d’extraire l’information « utile » dans l’image résultant de la différence des NDVI. Deux masques sont 

successivement appliqués. Le premier permet de découper la donnée suivant les limites de la zone d’étude (par 

exemple, une sylvo-écorégion). Le second, issu de la couche « végétation » de la BD Topo® IGN, permet 

d’extraire les zones boisées. Les pixels situés en dehors de la zone d’étude et des forêts sont alors codés en 

valeur nulle ou « no data ». À noter que depuis 2014, les services déconcentrés du Ministère de l’Agriculture 

(DDT et DRAAF) ont accès à la  BD Forêt® IGN qui présente l’avantage par rapport à la BD Topo® d’identifier les 

formations caducifoliées et résineuses. 
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2.2.3 CLASSIFICATION DES COUPES RASES 

Suite au calcul des deux NDVI et de leur différence, il convient d’identifier les changements au moyen de 

requêtes lancées via une calculatrice raster. Dans cette méthode et par souci de généricité, la distribution des 

valeurs de pixels du ΔNDVI est supposée suivre une loi normale. En outre la forêt qui n’a pas changé peut 

cependant voir son NDVI varier légèrement, et son ΔNDVI varie donc dans une plage de plus ou moins un écart-

type autour de la moyenne. Les valeurs situées entre le minimum (-2) et la moyenne des valeurs de ΔNDVI moins 

un écart-type traduisent alors le passage d’un sol boisé à l’année n à un sol nu ou peu végétalisé à l’année n+1. 

TUVWêYU1 = [−2 < OBPQR < (] − ^)]      (11) 

où m et σ sont respectivement la moyenne et l’écart-type des valeurs des pixels sur l’image ΔNDVI.  

La requête 1 livre en sortie une image binaire dans laquelle les pixels positifs (codés 1) correspondent aux 

zones supposées coupées. Ce résultat reste imprécis et difficilement interprétable puisqu’il attribue une même 

valeur à différents types de coupes : coupes récentes ou anciennes, coupes certaines ou probables… Il est donc 

proposé de discrétiser les valeurs comprises dans l’intervalle de la requête 1 en trois classes ordonnées suivant 

un degré de certitude. Ainsi, plus la valeur d’un pixel s’éloigne de la moyenne de ΔNDVI, plus forte est la 

certitude que ce soit une coupe rase récente. L’écart-type dimensionne l’amplitude des classes. L’expression 

est alors exprimée comme suit : 

TUVWêYU2 ∶         (12) 

,UaTé1	 = [(] − 2 ∗ ^) ≤ OBPQR < (] − ^)] 

,UaTé2	 = [(] − 3 ∗ ^) ≤ OBPQR < (] − 2 ∗ ^)] 

,UaTé3	 = [−2 < OBPQR < (] − 3 ∗ ^)] 

De cette requête résulte une image codée en entiers compris entre 0 et 3. La valeur 0 désigne toute partie de 

l’image sans forêt, les valeurs 1 à 3 correspondent aux détections de coupes avec un degré de certitude faible, 

moyen ou fort. En pratique, le degré 1 contient le plus souvent de fausses détections causées par des effets 

atmosphériques ou topographiques (ombres). 

2.3 EXPORT EN MODE VECTORIEL 

2.3.1 POST-TRAITEMENTS 

Les données binaires issues de la requête 1 ou 2 comportent des pixels « isolés » qui donnent aux images un 

effet « poivre et sel ». Bien que ce ne soit pas indispensable, il convient si possible de corriger ces défauts afin 

de respecter la spécification d’une surface minimale de détection de 1 hectare. Plusieurs solutions techniques 

sont envisageables pour filtrer les images, notamment sous QGis. Cependant, ce guide se base uniquement sur 

les outils proposés par défaut. 

2.3.2 VECTEUR ET ATTRIBUTS 

Les images de la requête 2, post-traitées ou non, sont converties en vecteur au format shapefile (ESRI). Chaque 

entité récupère en attribut le degré de certitude. La table attributaire en sortie est enrichie de nouveaux 

champs, au minimum : 

• nuage :   identification visuelle des nuages sur les images (=oui/non) 

• surface :  superficie en hectare de l’entité 
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Enfin, les entités inférieures à 1 ha (champ surface) et les erreurs liées à la présence de nuages dans l’image 

sont supprimées ou à défaut, exclues des restitutions cartographiques et des calculs statistiques. 

2.3.3 SUPERPOSITION DES VECTEURS (FACULTATIF) 

Dans le cas où plusieurs images couvrent la zone d’étude, les couches vectorielles résultantes peuvent être 

assemblées dans un même fichier. Ce dernier est constitué au moyen d’une union géométrique (outil de 

géotraitement). Il conserve les attributs des entités en entrée. 

Dans les zones de recouvrement, les entités intersectées se retrouvent avec deux de degrés de certitude 

souvent différents puisque les images satellitaires sont rarement acquises à la même date. Il faut donc 

recalculer cet indicateur afin de synthétiser l’information issue des couches vectorielles en entrée. Deux 

méthodes (cf. Figure 8), au choix, sont ici proposées : la moyenne et la concaténation. À la différence de la 

moyenne, la concaténation a l’avantage d’assurer une « traçabilité » des valeurs issues des deux vecteurs. Les 

unités définissant le degré de certitude issu de la première image, les dizaines celui de la seconde image. 

 

Figure 8. Assemblage des vecteurs de coupes rases détectées 

2.4 EVALUATION STATISTIQUE 

En fin de chaîne de traitements, la qualité d’extraction des coupes rases est évaluée. Elle est déduite au moyen 

d’une matrice de confusion (Tableau 4). Chaque colonne de la matrice représente le nombre d’occurrences 

d’une classe estimée, tandis que chaque ligne représente le nombre d’occurrence de la référence. Le nombre 

d’occurrences peut être remplacé par la surface. Idéalement la donnée de référence découle d’une observation 

sur le terrain. Les parcelles expertisées sont ensuite comparées aux résultats de la classification.  

À partir de cette matrice, sont calculées : 

• La précision globale, elle désigne la proportion d’entités bien classées (diagonale de la matrice). 

• La précision pour l’utilisateur, soit la proportion d’entités d’un groupe issu de la classification bien 

classées vis-à-vis de la référence. Elle se lit en colonne. 

• La précision pour le producteur, soit la proportion d’entités d’un groupe de référence correctement 

classées par télédétection. Elle se lit en ligne. 

• Les erreurs d’omission et de commission, elles traduisent l’attribution à une entité d’un intitulé 

erroné. Plus simplement, elles indiquent si le processus de classification a plutôt tendance à 

surestimer ou bien à sous-estimer le nombre (ou la surface) des entités appartenant à une classe 

d’occupation du sol. 
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Tableau 4. Exemple de matrice de confusion 

  
classification 

  
Coupes rases Autres 

Total 
lignes 

Précision 
producteur (%) 

Erreur 
d’omission (%) 

ré
fé

re
n

ce
 

Coupes rases X11 X12 N1 100.
�;;

D;

 100.
�;S

D;

 

Autres X21 X22 N2 100.
�SS

DS

 100.
�S;

DS

 

Total colonnes M1 M2 N 
  

Précision 
utilisateur (%) 

100.
�;;

�;

 100.
�SS

�S

  
  

Erreur de 
commission (%) 

100.
�S;

�;

 100.
�;S

�S

  
  

       
 

Précision globale 100.
�;; 	�SS

D
   

  

2.5 LIMITES DE LA MÉTHODE 

La méthode de détection des coupes rases par différence des NDVI est opérationnelle et transposable sur des 

outils SIG ou sur des jeux de données satellitaires variés. Toutefois, le résultat obtenu peut ne pas être une 

détection véritablement annuelle des coupes rases et ce, pour deux raisons au moins : 

1. La constitution d’une couverture satellitaire sur l’ensemble du territoire national, acquise 

généralement en période estivale, est en fait étalée sur plusieurs mois de l’année, entre le printemps 

et l’automne (cf. Figure 9). Sur chaque zone du territoire, parmi les images acquises, seule celle 

présentant la meilleure qualité (le moins de nuages) est conservée. Par conséquent, sur une même 

sylvo-écorégion, les dates des images voisines sont parfois espacées de plusieurs mois. La détection 

n’est donc pas un bilan des coupes réalisées sur une année entière, mais seulement sur la période 

séparant les deux images. Sur certains pans de territoire, cela peut se traduire par une détection des 

coupes entre le mois d’octobre et le mois de mai de l’année suivante, soit une détection sur un 

intervalle de sept mois. 

 

Figure 9. Répartition temporelle des acquisitions de la couverture RapidEye 2010 

2. L’indice de végétation permet de différencier aisément les surfaces végétalisées des surfaces en sol 

nu. Or l’état de sol nu suite à une coupe rase est très bref. La végétation reprend le dessus en 

quelques mois. La différence des NDVI est donc particulièrement appropriée pour détecter des coupes 

récentes, beaucoup moins pour des coupes anciennes. Elle sera donc adaptée à un rythme annuel de 

détection des coupes. 
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3 TRANSPOSITION DE LA MÉTHODE SOUS QGIS 

3.1 PRÉ-REQUIS 

3.1.1 SAVOIR-FAIRE ET FORMATIONS 

3.1.1.1 SAVOIRS THÉORIQUES ET OPÉRATIONNELS 

Le guide méthodologique est conçu pour un public d’ingénieurs et techniciens disposant de connaissances 

avancées en traitement et en analyse de données numériques à référence spatiale. La maîtrise des principes de 

base en télédétection est facultative bien que très utile. 

En termes de savoir-faire, il est indispensable de bien connaître le fonctionnement du logiciel QGis, notamment 

pour la gestion, le traitement et l’analyse de données raster. Des manipulations de base sur les tableurs sont 

aussi requises. 

Si besoin, des formations courtes en SIG et traitements d’images satellitaires sont assurées à Montpellier, au 

sein de la Maison de la Télédétection. Certaines de ces sessions sont inscrites au catalogue Formco du 

Ministère de l’Agriculture et sont accessibles aux agents en faisant la demande selon la procédure habituelle, 

dans la limite des places disponibles. 

3.1.1.2 FORMATIONS TETIS-AGROPARISTECH 

GeoSud et son partenaire AgroParisTech proposent une formation courte, gratuite pour les agents du MAAF, 

pour découvrir l’imagerie satellitaire du territoire français mise gratuitement à disposition des acteurs publics 

et ses applications potentielles. La formation comporte deux sessions : 

• Session 1, Initiation à la télédétection avec Geosud et QGis (2 jours) : présentation des principes de la 

télédétection et des méthodes de traitements des images, initiation aux premiers usages, comme le 

calcul d’indices et la détection de changements. 

• Session 2, Pratique de la télédétection avec Geosud et QGis (3 jours) : description des méthodes de 

segmentation et de classification des images, avec un approfondissement sur les techniques 

d’automatisation et de chaînage des traitements. 

Chaque session propose en plus un module « application thématique » optionnel. Les sessions 1 et 2 sont 

suivies respectivement de : 

• Application thématique Geosud, Détection des coupes rases en forêt (2 jours) : description et mise 

en pratique de la méthode de détection des coupes rases en forêt dans un objectif de transfert de 

compétences (session gratuite pour les agents du MAAF). 

• Application thématique Geosud, Détection des CIPAN en agriculture (3 jours) : description et mise en 

pratique de la méthode de détection des cultures intermédiaires pièges à nitrates dans un objectif de 

transfert de compétences (session payante pour les agents du MAAF). 

AgroParisTech et l’UMR Tetis proposent également un ensemble cohérent de sessions pouvant se structurer en 

un parcours qualifiant ou certifiant individualisé. Le contenu et le tarif des formations sont détaillés sur la page 

Web suivante : 

http://www.agroparistech.fr/Programmes-courts-de-formation.html 
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3.1.2 MATÉRIELS ET LOGICIELS 

3.1.2.1 LOGICIELS REQUIS 

Les traitements raster et vectoriel prévus par la méthode de détection des coupes rases font appel à la 

bibliothèque GDAL. Ses fonctionnalités sont interfacées dans le logiciel libre et gratuit QGis. 

L’utilisation d’un tableur est aussi nécessaire pour construire des graphiques, déduire des droites de régression 

ou élaborer une matrice de confusion. S’agissant de manipulations relativement basiques, tout tableur, 

propriétaire ou libre, convient. Les traitements sont ici réalisés sous LibreOffice Calc. 

3.1.2.2 CONFIGURATION MATÉRIELLE 

Il n’y a pas de configurations matérielles officielles pour QGis. De plus, la plupart des fonctionnalités offertes 

par le logiciel ne tire pas profit des microprocesseurs multi-cœur. La rapidité d’exécution dépend donc des 

données utilisées et des traitements appliqués. 

Pour appliquer la méthode de détection des coupes rases, il est souhaitable d’avoir une configuration 

respectant au minimum les caractéristiques suivantes : 

• Système d’exploitation :  Windows 7 (32 bits) 

• Mémoire vive :   8Gb 

• Stockage :   1 à 2To 

3.1.3  DONNÉES EN ENTRÉE 

3.1.3.1 JEUX DE DONNÉES UTILES 

La mise en œuvre de la méthode nécessite de récupérer et de préparer le cas échéant (transformation en 

Lambert 93 RGF93) quatre jeux de données (Tableau 5) : 

Tableau 5. Jeux de données en entrée de la chaîne de traitements 

donnée Source 

Images satellitaires à l’année n GMES, GeoSud, Theia 

Images satellitaires à l’année n+1 GMES, GeoSud, Theia 

Couche vectorielle des sylvoécorégions IGN 

Couche vectorielle Végétation BD Topo® ou BD Forêt ® IGN 

3.1.3.2 MODALITÉS D’ACQUISITION 

L’obtention des données, quel que soit le fournisseur, nécessite de s’enregistrer pour pouvoir accéder au 

catalogue et finalement télécharger. 

Les procédures d’enregistrement sont décrites sur les pages Web suivantes : 

• GMES :  
http://gmesdata.esa.int/web/gsc/how-to-access-gsc-data 

• Geosud :  
http://www.equipex-geosud.fr/web/guest/comment-adherer 

• IGN :  
http://professionnels.ign.fr/user/register 
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3.2 PRÉSENTATION DU LOGICIEL QGIS 

3.2.1 UN LOGICIEL LIBRE 

QGis – ou Quantum GIS – est un logiciel libre SIG publié sous la GNU Public License (GPL). Ce projet, né en 2002, 

et mené par une équipe internationale de développeurs, est aujourd’hui officiellement soutenu par la 

fondation Open Source Geospatial (OSGeo). 

Multiplateforme, puisqu’il fonctionne sous Linux, Unix, Mac Os X et Windows, cet outil prend aussi en charge la 

plupart des formats vectoriels et rasters ainsi que les connexions aux bases de données à référence spatiale 

telles que PostGIS ou Spatialite. 

QGis dispose d’une liste sans cesse enrichie de fonctionnalités grâce à un puissant système d’extensions. 

Aujourd’hui ce logiciel est pour ainsi dire complet. Il permet de visualiser, gérer, éditer et analyser les données, 

sans oublier la possibilité de composer des cartes pour impression. 

La dernière version publiée est la 2.6.0, nommée « Brighton ». Elle est téléchargeable sur le portail 

www.qgis.org. 

3.2.2 INSTALLATION DE QGIS 

N.B. : Ce document présente uniquement l’utilisation sous Windows de QGis version 2.4.0 « Chugiak ». Pour les 

autres systèmes d’exploitation, le lecteur est invité à consulter la documentation mise à disposition dans le 

portail Web officiel de QGis. 

Sous Windows, deux solutions sont proposées pour installer le logiciel QGis : 

1. Installateur indépendant (version recommandée) : il s’agit d’un exécutable (.exe). Cette version 

comporte toutes les dépendances nécessaires aux fonctions et aux extensions principales. Elle inclut 

par défaut GRASS, bibliothèque de traitements vectoriels et raster très performante. 

2. Installateur réseau OSGeo4w : Cette version fonctionne directement depuis internet et permet de 

personnaliser le téléchargement des paquets requis tout en gérant les dépendances. Elle est utile aux 

utilisateurs souhaitant installer des bibliothèques de fonctionnalités spécifiques, ou faire appel à des 

invites de commandes ou des scripts python… 

Lien Web de téléchargement : http://qgis.org/fr/site/forusers/download.html 

3.2.3 CONFIGURATION DE QGIS 

QGis intègre régulièrement de nouvelles bibliothèques de traitements très performantes et reconnues dans le 

monde de la recherche. Par exemple l’OTB (Orfeo ToolBox) Applications, développé par le CNES, est dédié 

exclusivement aux donnés de télédétection. D’autres encore proposent quelques algorithmes pour traiter les 

images satellitaires, notamment Grass (Geographic Resources Analysis Support System) et Saga (System for 

Automated Geoscientific Analysis). En général, elles ont l’avantage d’être plus performantes en termes de 

fiabilité des résultats et de temps de calcul. Pour plus d’informations sur ces outils, il est conseillé de consulter 

les pages Web dédiées : 

• OTB Applications :  http://www.orfeo-toolbox.org/otb/otb-applications.html 

• Grass GIS :   http://grass.osgeo.org 

• Saga GIS :   http://www.saga-gis.org 
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Toutes les installations de QGis n’intègrent pas l’ensemble de ces bibliothèques (par exemple, la version 

packagée sur l’Espace Interministériel de l’Information Géographique). En outre, l’installation de ces dernières 

n’est pas toujours aisée. C’est pourquoi, ce guide transpose la méthode de détection des coupes rases en 

utilisant uniquement les outils de QGis. Ce choix favorise donc la généricité au détriment de la performance. 

Cependant, pour certaines étapes de traitements, le guide indiquera les alternatives possibles sur Grass et OTB. 

3.3 DESCRIPTION DE LA CHAÎNE DE TRAITEMENTS  

La Figure 10 illustre la succession des traitements requis pour la détection des coupes rases. Pour faciliter sa 

lecture, les traitements sont regroupés en 7 principales étapes, depuis la détection des changements jusqu’à la 

qualification des résultats obtenus. La transposition de la méthode, décrite ci-après, est présentée 

conformément à cet organigramme. 

 

Figure 10. Chaîne de traitements 
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3.4 ÉTAPE 1 : DÉTECTION DES CHANGEMENTS 

 

Pour suivre l’évolution de l’occupation du sol, l’approche proposée ici consiste à créer une image de 

changements des états de surface. Dans un premier temps, les images satellitaires acquises à différentes dates 

sont converties en réflectance puis transformées en indices de végétation. De la différence de ces indices 

résulte une image monocanal dans laquelle il est possible de visualiser deux principaux types de modifications : 

le passage d’un état végétalisé à un état sol nu ou autre, et inversement. 

3.4.1 CONVERSION DES DONNÉES SATELLITAIRES EN RÉFLECTANCE TOA 

L’énergie réfléchie par la surface de la Terre et enregistrée par le capteur dans chaque bande spectrale est 

codée en comptes numériques (CN) 8 à 16 bits. À partir du CN, il est possible de retrouver la luminance reçue 

en utilisant les coefficients de calibration fournis par l’opérateur du satellite. Cependant, pour un même 

couvert végétal, la luminance varie en fonction de l’éclairement solaire, lequel dépend de la saison et de 

l’heure. Pour comparer les images entre elles, il est alors intéressant de normaliser le rayonnement réfléchi par 

le rayonnement incident et donc de convertir la luminance en réflectance comme indiqué dans l’équation 5 

(page 9). 

En entrée de cette étape, deux images au moins sont nécessaires. Elles correspondent chacune à une année 

d’étude et seront nommées annee1  et annee2  dans la description des traitements qui suit. 

3.4.1.1 PARAMÈTRES DE CONVERSION 

Chaque capteur dispose d’une métadonnée spécifique. Néanmoins, toutes fournissent les informations 

nécessaires à la conversion en réflectance TOA. 

Démarche Manipulation sous QGis 

 
1. Ouverture du 

fichier de 
métadonnées 

 
Ouvrir le fichier métadonnée de l’image à traiter dans un éditeur de texte (Bloc-notes, 
Notepad++, ou autres). 

• Pour SPOT : metadata.dim  

• Pour RapidEye : [ nom de l’image ].xml  

• Pour IRS : calib.dat  et [ nom de l’image ].txt 
• Pour Landsat 8 : [ nom de l’image ]_MTL.txt 

 
Remarque : 
Les paramètres utiles à la calibration en réflectance TOA varient d’une image à l’autre. Excepté 
la luminance équivalente solaire qui est constante pour chaque bande spectrale et ce, quelle 
que soit la date d’acquisition. 
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2. Récupération des 

paramètres dans 
la métadonnée 
DIMAP de SPOT 

 

 
Pour chaque bande spectrale (<BAND_DESCRIPTION>), récupérer les informations 
suivantes :  
 

1. Le gain et le biais 

 
 

2. L’angle d’élévation solaire 

 
 

3. La luminance équivalente solaire eSun 
Cf. lien Web : http://www.astrium-geo.com/files/pmedia/public/r1983_9_spot_luminancesequivalentessolaires.pdf 

Pour une image SPOT, repérer le numéro de l’instrument :  

 
 
Si <INSTRUMENT_INDEX> = 1 : la luminance solaire vaut : 

pIR = 1043, rouge = 1573, vert = 1858 et mIR =  236 
Si <INSTRUMENT_INDEX> = 2 : la luminance solaire vaut : 

pIR = 1047, rouge = 1575, vert = 1858 et mIR =  234 
 
Exemple pour une image SPOT5 : 

Bande Spot Gain Angle solaire 
Distance 
Terre-Soleil 

Lum. solaire 

pIR 1 XS3 2.387028 35,715516 1 1047 

Rouge 2 XS2 3.826256 35,715516 1 1575 

Vert 3 XS1 2.887995 35,715516 1 1858 

mIR 4 SWIR 18.419145 35,715516 1 234 

 
N.B. Dans la méthode présentée ici, les informations relatives au vert et au moyen infrarouge ne 
sont pas nécessaires.  
 

 
3. Récupération des 

paramètres dans 
la métadonnée 
RapidEye 

 
Pour chaque bande spectrale (<re:bandNumber> ), récupérer : 
 

1. le facteur de correction radiométrique : 

 
 
N.B. À défaut, il est possible de considérer ce facteur comme étant égal à 0.01  pour toutes les 
bandes spectrales. 
 

2. L’angle d’élévation solaire 

 
 

3. La luminance équivalente solaire eSun 
bleu = 1997.8, vert = 1863.5, rouge =  1560.4, rededge = 1395.0, pIR =  1124.4 
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4. Récupération des 

paramètres dans 
les métadonnées 
IRS 

 
Dans le fichier calib.dat , récupérer pour chaque bande : 
 

1. les valeurs de luminance maximum et minimum 

 
 
Dans le fichier [ nom de l’image ].txt , récupérer : 
 

2. L’angle d’élévation solaire 
Cf. lien Web : http://www.rapideye.com/about/resources.htm?tab=9#TabbedPanels1 

 
 

3. La luminance équivalente solaire eSun (pour capteur Liss-3) 
Cf. lien Web : http://www.euromap.de/pdf/IRS_exoatm.pdf 

vert = 1849.5, rouge =  1553.0, pIR =  1092.0, mIR = 239.52 
 

 
5. Récupération des 

paramètres dans 
les métadonnées 
Landsat 8 

 
Pour chaque bande spectrale (GROUP = L1_METADATA_FILE), récupérer les informations 
suivantes : 
 

1. Le facteur de correction multiplicatif 
Dans le sous-groupe RADIOMETRIC_RESCALING 

 
 

2. Le facteur de correction additif 
Dans le sous-groupe RADIOMETRIC_RESCALING 

 
 
3. L’angle d’élévation solaire 
Dans le sous-groupe IMAGE_ATTRIBUTES 
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3.4.1.2 CRÉATION DU MASQUE DE L’EMPRISE 

Le plus souvent, les images satellitaires géoréférencées se présentent à l’affichage tel un rectangle incliné. Les 

pixels situés en dehors complètent l’emprise mais n’apportent aucune information. La création d’un masque 

est alors conseillée pour conserver tout au long des traitements une information sur la localisation des pixels 

valides et non valides. 

Démarche Manipulation sous QGis 

 
1. Ouverture de 

l’image 
 

 
Ouvrir QGis 
 
Dans la barre des menus : 

• Cliquer sur : Couche > Ajouter une couche raster… ou cliquer sur  

• Sélectionner l’image satellitaire annee1 . 
 

 
2. Présentation de la 

calculatrice Raster 

 
Dans la barre des menus : 

• Cliquer sur : Raster > Calculatrice 
Raster.  

 
La calculatrice raster apparaît. Elle 
comporte 4 blocs : 

 
1. La liste des canaux d’image 

disponibles (ouverts sous QGis) 
2. La couche résultat : nom de la 

couche raster en sortie, format et 
étendue 

3. Les opérateurs de calcul 
4. Un champ de formule 

 
 

 
3. Création du 

masque de 
l’emprise annee1 

 
Dans la calculatrice Raster : 

• Sélectionner les bandes spectrales rouge et proche infrarouge et, saisir l’expression 
suivante dans le champ de formule : 
 

"annee1@x" > 0 AND "annee1@y" > 0 
 
Où x et y correspondent respectivement à l’index des bandes rouge et proche infrarouge. 
 

• Cliquer sur Étendue actuelle de la couche en sélectionnant au préalable la bande 
raster utilisée 

• En sortie, nommer le résultat annee1_emprise.tif  
 
L’image créée est un masque binaire. Les pixels codés 1 (blanc) correspondent aux pixels 
informés, ceux codés 0 (noir) aux pixels invalides (bordure de l’image). 
 

 

→ 

 
  

 
4. Création du 

masque de 
l’emprise annee2 

 

• Répéter la dernière opération pour l’image de l’année suivante et, 

• Nommer le fichier en sortie annee2_emprise.tif 
 
 
 

1 2 

3 

4 
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5. Fusion de 

masques 

 
Ouvrir les fichiers d’emprise annee1_emprise.tif  et annee2_emprise.tif 
Dans la calculatrice Raster : 

• Saisir l’expression suivante dans le champ de formule : 
 

"annee1_emprise @1" * "annee2_emprise @1" 
 

• En sortie, nommer le résultat emprise_globale.tif  
 

3.4.1.3 CONVERSION EN RÉFLECTANCE TOA 

Le passage en réflectance TOA est une étape délicate car la valeur de la plupart des paramètres requis change 

pour chaque bande spectrale d’une même image. De plus, les expressions sont différentes entre capteurs. Sous 

QGis, cette conversion peut être réalisée au moins de deux manières, soit par la calculatrice Raster, soit par un 

plugin dédié. 

Démarche Manipulation sous QGis (calculatrice Raster) 

 
1. Ouverture de 

l’image  

 
Ouvrir QGis 
 
Dans la barre des menus :  

• Cliquer sur : Couche > Ajouter une couche raster… ou cliquer sur  

• Sélectionner l’image satellitaire à traiter (annee1 ou annee2 ). 
 

 
2. Utilisation de la 

calculatrice Raster 
et conversion en 
réflectance TOA 

 
Dans la barre des menus : 

• Cliquer sur Raster > Calculatrice Raster. La calculatrice raster apparaît. 
 
Dans la calculatrice Raster : 

• Pour chaque bande spectrale utile (rouge et proche infrarouge), copier l’équation 
correspondant au type de capteur (SPOT, RapidEye, etc.) dans le champ de formule en 
remplaçant les constantes (en gras) par celles récupérées dans les métadonnées : 

 
Satellite Expression 

SPOT 
( π * distanceTerre-Soleil^2 * Valeur_pixel) /  
( eSun[band] * cos(( π / 180) * (90 - angleElevationSolaire)) * 
PHYSICAL_GAIN[band])  

RapidEye 
( π *  distanceTerre-Soleil^2 * Valeur_pixel * 
radiometricScaleFactor[band]) / ( eSun[band] * cos(( π / 180) *  
(90 –  angleElevationSolaire))) 

IRS 

Lm: 
(((( LMAX[band]) -  ( LMIN[band])) * Valeur_pixel) / 255) + 
( LMIN[band]) 
TOA : 
( π * distanceTerre-Soleil^2 * Lm) /  
( eSun[band] * cos(( π / 180) *  (90 -  angleElevationSolaire))) 

Landsat 8 
( RADIANCE_MULT_BAND_[band]* Valeur_pixel + 
RADIANCE_ADD_BAND_[band]) / (cos(( π /180) * (90 - 
angleElevationSolaire))  

 
Par exemple pour la bande spectrale rouge de Spot, cela donne : 
 
(3.14* 1^2*5_051010@2)/( 1575*cos((3.14/180)*(90- 35.715516))* 3.826256)  
 

Le nom de la bande respecte la syntaxe suivante : nom_image@numéro_bande 
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• En sortie, indiquer le nom de la nouvelle image, par exemple :  
o annee1_toa_pir.tif  et annee1_toa_rouge.tif . 

 
 

  
Répéter la dernière opération pour l’image de l’année suivante et, 
Nommer les fichiers en sortie annee2_toa_pir.tif  et annee2_toa_rouge.tif 
 

 

Démarche Manipulation sous QGis (plugin) 

 
1. Installation de 

l’extension 
Geosud Toa 
Reflectance 

 
Une extension QGis, développée par Irstea/Geosud, permet de convertir automatiquement en 
réflectance TOA les images issues des capteurs Spot 5, RapidEye et Landsat 8. Cet outil 
reproduit les procédures décrites ci-dessus. Il permet d’éviter des erreurs de manipulations et 
de gagner en temps de traitements. 
 
Dans la barre des menus, cliquer sur Extension > Installer/Gérer les extensions  
 
Dans la fenêtre Extensions : 
 

• Cliquer sur l’onglet Paramètres et, 
o cocher Afficher les extensions expérimentales 

• Cliquer sur l’onglet Non installé 
o Dans le champ Rechercher, saisir geosud ,  
o Sélectionner l’extension Geosud Toa Reflectance  et, 

• Cliquer sur Installer l’extension 
 

 
 

L’extension peut être appelée de deux manières : 
 

• Dans la barre des menus 
o Cliquer sur Extension > Geosud Toa Reflectance > geosud Toa ou, 

• Cliquer sur l’icône  dans la barre des extensions 
 

 
2. Description de 

l’extension 
Geosud Toa 
Reflectance 

 
L’extension Geosud Toa Reflectance est 
interfacée de manière à respecter les étapes 
suivantes : 
 

1. Choix du capteur, 
2. Chargement de l’image, 
3. Chargement de la métadonnée, 
4. Affichage des paramètres requis 

pour la conversion en TOA, 
5. Choix du codage en sortie,  
6. Création de l’image en réflectance 

TOA.  
 
 
 

1 

2 

3 

4 

5 

6 
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3. Exemple 

d’utilisation 

 
Dans la fenêtre de l’extension Geosud Toa Reflectance : 
 

• Sélectionner un instrument (RapidEye , Spot5  ou Landsat8 ) 

• Dans le champ Load Image(s), cliquer sur le bouton … 
o Si RapidEye  ou Spot5  sont cochés, charger une image multispectrale 

 

 
 

o Si Landsat8  est coché, sélectionner une ou plusieurs bandes spectrales 
(N.B. : ne fonctionne pas pour l’infrarouge thermique) 
 

 
 

• Dans le champ Load Metadata : 
o Cliquer sur le bouton auto, l’extension recherche automatiquement la 

métadonnée associée. 
Si le nom ou l’emplacement de la métadonnée a été modifié : 
o Cliquer sur le bouton … pour indiquer le chemin de la métadonnée  

• Cliquer sur le bouton get TOA parameters, les paramètres utiles à la conversion en 
réflectance TOA s’affichent, 

• Dans le champ Output format, choisir le codage des fichiers créés : 
o reflectance (32 bits) : les valeurs de pixels sont des nombres décimaux 

compris entre 0 et 1 
o milli-reflectance (16 bits) : les valeurs de pixels sont des entiers naturels 

compris entre 0 et 1000. 

• Cliquer sur convert DN to TOA. Les fichiers en sortie (GeoTiff uniquement) sont 
stockés par défaut dans le même répertoire que les fichiers sources. Pour spécifier un 
autre emplacement, cocher au préalable l’option output directory et indiquer le 
répertoire en cliquant sur le bouton … 
 

Le nom des fichiers en sortie comporte le nom d’origine auquel est ajouté un suffixe, 
‘_refToa16.tif’  ou ‘_refToa32.tif’  selon le codage choisi. 
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4. Compilation des 

bandes converties 
en réflectance 
TOA (facultatif) 

 
Dans la barre des menus : 

• Cliquer sur : Raster > Divers > Fusionner 
 
Dans la fenêtre fusionner : 
 

• sélectionner les 3 fichiers raster créés 
précédemment 
(annee1_pir_toa.tif , 
annee1_rouge_toa.tif , 
annee1_vert_toa.tif ) 

 
N.B. L’ordre de sélection correspond à l’ordre dans 
lequel seront positionnées les bandes dans la 
nouvelle image. 
 

• Renseigner le nom et l’emplacement du 
fichier en sortie, par ex. 
annee1_multi_toa.tif 

• Cocher Pile de couches 
 
L’image obtenue comporte trois canaux (pIR, rouge et vert). Il est possible de l’afficher en 
composition colorée « fausses couleurs » (végétation en rouge)  
 

  
Répéter l’étape 7 pour chaque image satellitaire 
 

  
À ce stade 4 fichiers par date sont produits  
 
N.B. Les sorties en italique sont utiles uniquement pour une égalisation radiométrique par la 
méthode des invariants (cf. § 3.4.2).  
 

annee1_toa_rouge.tif  annee2_toa_rouge.tif  
annee1_toa_vert.tif annee2_toa_vert.tif 
annee1_toa_pir.tif annee2_toa_pir.tif 
annee1_toa_multi.tif  annee2_toa_multi.tif  

  

3.4.2 EGALISATION RADIOMÉTRIQUE : MÉTHODE DES INVARIANTS (FACULTATIF) 

Même si deux images sont acquises sur la même zone à une année d’intervalle 
dans des conditions d’éclairement similaires, la composition de l’atmosphère 
diffère le plus souvent, et altère de fait le signal capté par le satellite. Il est alors 
souhaitable d’appliquer une normalisation radiométrique relative pour réduire 
l’impact des effets atmosphériques sur la réflectance enregistrée. Le principe est 
de choisir une image de référence, celle qui présente la meilleure dynamique 
radiométrique, pour normaliser la seconde image (cf. Figure 11). Cette méthode 
recourt à la normalisation par cibles invariantes, lesquelles sont sélectionnées sur 
une zone commune aux deux images. 

Cette méthode est recommandée, sans être obligatoire, pour comparer un couple 
d’images acquises à deux dates différentes sur une même zone. Au-delà de deux 
images, elle est fortement déconseillée en raison d’un risque fort de propagation 
d’erreur.  

Dans l’exemple ci-contre, l’image de référence est l’année 1 car l’étendue de sa dynamique est 

supérieure à celle de l’année 2. La radiométrie de l’image de l’année 2 est donc corrigée sur la base des 

statistiques issues des cibles invariantes.  

 

Figure 11. Égalisation 

radiométrique 
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3.4.2.1 CHOIX DE L’IMAGE DE RÉFÉRENCE 

L’égalisation radiométrique a pour principe de corriger les images en fonction d’une référence. Celle-ci est 

choisie en fonction de sa dynamique. 

Démarche Manipulation sous QGis 

 
1. Ouverture des 

images dans QGis 
et, 
choix de l’image 
de référence 

 
Dans la barre des menus : 

• Cliquer sur : Couche > Ajouter une couche raster… ou cliquer sur  

• Sélectionner les 2 images converties en réflectance  
o annee1_multi_toa.tif  
o annee2_multi_toa.tif 

 

 
2. Actualisation des 

statistiques de 
l’image et, 
sélection de 
l’image de 
référence 

 
Dans la liste des couches : 

• Double-cliquer sur le nom de la 1
ère

 image, la fenêtre des propriétés de la couche 
s’affiche. 

Dans la fenêtre des propriétés : 

• Cliquer sur l’onglet Style et noter les valeurs min/max de l’image. 

 
• Si ces valeurs ne sont pas disponibles, cocher le bouton radio Réelle (plus lente) dans 

le bloc Charger les valeurs min/max depuis la bande, puis cliquer sur le bouton 
Charger. 

 
• Répéter l’opération pour la seconde image. 

 
L’image ayant la plus grande étendue (max-min) dans le proche infrarouge correspond à l’image 
de référence.  
 
Dans le cadre de cet exercice, la référence correspond à l’image de l’année 1 
(annee1_multi_toa.tif ). 
 

3.4.2.2 SAISIE DES CIBLES INVARIANTES 

Les cibles invariantes permettent de construire la correspondance radiométrique entre la ou les image(s) 

cible(s) et l’image de référence. Cette donnée requiert l’intervention d’un opérateur qui les digitalise par 

photo-interprétation. 

Démarche Manipulation sous QGis 

 
1. Création de la 

couche vectorielle 
des cibles 
invariantes 

 
Dans la barre des menus : 

• Cliquer sur Couche > Nouveau > Nouvelle couche shapefile… 
 

Dans la fenêtre Nouvelle couche vecteur, renseigner : 

• le type de géométrie : Polygon   

• le système de projection, cliquer sur le bouton Specify CRS : 
o Dans la fenêtre Coordinate Reference System Selector, sélectionner 

RGF93/Lambert-93  (cette référence peut être retrouvée au moyen du 
champ filtre en entrant le numéro de l’EPSG correspondant, à savoir 2154 ) 

• Cliquer sur OK et nommer le shapefile, par exemple Parcelle_calib.shp  
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2. Sélection des 

cibles invariantes 

 
Dans la barre des menus : 

• Cliquer sur : Couche > Ajouter une couche vecteur… ou cliquer sur   

• Ouvrir le shapefile créé à l’étape 1 (Parcelle_calib.shp ) 

• Basculer en mode Edition en cliquant sur  
o Zoomer sur la zone commune aux deux 

images, 
o Repérer une première zone n’ayant pas 

changé entre les deux dates (sol nu, forêt 
dense, bâtiment, parking, lac…)  

o Cliquer sur  et digitaliser les contours de 
cette zone. 
(clic gauche pour créer un nouveau nœud, 
clic droit pour fermer le polygone).  

 
De la même manière, dessiner une vingtaine de polygones en variant les types d’occupation du 
sol. 

• Sauvegarder les polygones en cliquant sur  

• Quitter le mode Edition en cliquant de nouveau sur  
 

 
3. Calcul des 

statistiques 
zonales 

 
Ouvrir les images TOA :  
 

annee1_toa_rouge.tif  annee2_toa_rouge.tif  
annee1_toa_vert.tif annee2_toa_vert.tif 
annee1_toa_pir.tif annee2_toa_pir.tif 

 
Afin de calculer la valeur moyenne des pixels inclus dans chaque polygone des cibles 
invariantes, il faut charger l’extension Zonal Statistics sous QGis. 
 
Cliquer sur Extensions > Gestionnaire des extensions, une fenêtre comportant un certain 
nombre d’extensions s’affiche.  
Dans le champ Filtrer, saisir Statistiques de Zone ou  Zonal Statistics  (en 
fonction de la langue choisie par défaut sur le logiciel), cocher l’extension et cliquer sur OK. 
 

 
 
Dans la barre des menus : 

• Cliquer sur : Raster > Statistiques de zone > Statistiques de zones ou cliquer sur , 
une fenêtre Dialogue s’affiche. 
 

Dans la fenêtre Dialogue : 

• Dans le champ Couche raster, choisir un 
raster, par exemple 
annee1_toa_rouge.tif  

• Dans le champ Couche de polygone, 
choisir le vecteur 
Parcelle_calib.shp  

• Dans le champ Préfixe de la colonne en 
sortie, saisir un nom explicite, par exemple 
d1_r  (pour date1, canal rouge).  
N.B. le préfixe ne doit pas dépasser 5 caractères. 

• Cliquer sur OK 
 

Répéter cette étape pour les 5 autres images TOA. 
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Normalement, 18 nouveaux champs ont été ajoutés dans la table attributaire du vecteur 
Parcelle_calib.shp. Ils correspondent aux effectifs (count ), sommes (sum) et 
moyennes (mean) des canaux proche infrarouge, rouge et vert pour chacune des deux dates. 
 

3.4.2.3 CALCUL DES DROITES DE RÉGRESSION ET ÉGALISATION RADIOMÉTRIQUE 

Les équations des droites de régression sont déduites sur la base des statistiques zonales associées aux cibles 

invariantes. Elles permettent de corriger les images vis-à-vis de la référence et de les rendre comparable 

finalement.  

Démarche Manipulation sous QGis 

 
1. Calcul de 

l’équation de la 
droite de 
régression 

 
Le calcul de l’équation de la droite de régression est réalisé sous un tableur. La procédure est 
décrite ici sous Excel mais d’autres logiciels peuvent être utilisés, notamment libres comme 
LibreOffice Calc. 
 
Démarrer Excel et ouvrir le fichier Parcelle_calib.dbf   
Enregistrer ce fichier au format Excel. 
 
Chaque ligne de la table correspond à une cible invariante (un polygone), chaque colonne décrit 
un attribut. Pour plus de lisibilité, il est conseillé de supprimer les champs relatifs aux effectifs et 
à la somme des pixels, c’est-à-dire ceux qui comportent les suffixes Count  ou Sum. 
 
Pour chaque bande spectrale (pIR, rouge et vert), créer le nuage de points en mettant en 
abscisse l’année à égaliser et en ordonnée celle de référence. 
 
Calculer ensuite l’équation de la droite de régression et le coefficient de détermination R² :  
 

• Clic-droit sur le graphique > Ajouter une courbe de tendance,  

• Cocher Afficher l’équation sur le graphique et  

• Cocher Afficher le coefficient de détermination (R²) sur le graphique 
 

 

 

 
  

 
2. Correction des 

images par 
rapport à la 
référence 

 
Retourner dans QGis 
 
Dans la barre des menus :  

• Cliquer sur Raster > Calculatrice Raster 
 
Dans la calculatrice Raster : 

• Dans le champ de formule, saisir l’équation de la droite de régression correspondant à  
chaque bande spectrale de l’image à égaliser. La valeur x est remplacée par la bande 
spectrale. 

• Nommer le fichier en sortie en ajoutant le suffixe « calib », par exemple 
annee2_toa_pir_calib.tif  
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Cette étape doit être réitérée autant de fois qu’il y a de canaux dans l’image cible. 
 

 
3. Compilation des 

canaux égalisés 

 
Une fois chaque bande spectrale égalisée, elles sont de nouveau assemblées pour obtenir une 
image multispectrale. 
 
Dans la barre des menus : 

• Cliquer sur : Raster > Divers > Fusionner 
 
Dans la fenêtre fusionner : 

• Sélectionner les 3 fichiers raster créés précédemment 
(annee2_toa_pir_calib.tif , annee2_toa_rouge_calib.tif , 
annee2_toa_vert_calib.tif ) 

 
N.B. L’indexation des bandes correspond à l’ordre de sélection. Ici, l’opérateur sélectionne 
d’abord le proche infrarouge et finit avec le vert. Donc, la bande 1 est attribuée au proche 
infrarouge, la bande 2 au rouge et la bande 3 au vert. 
 

• Renseigner le nom et l’emplacement du fichier en sortie, par ex. 
annee2_calib.tif 

• Cocher Pile de couches 
 

  
À la fin, il doit y avoir deux images multi-spectrales : une image de référence (ici, 
annee1_multi_toa.tif ) et une image calibrée (ici, annee2_calib.tif ). Chacune 
comporte trois canaux, dans l’ordre : proche infrarouge, rouge, et vert. 
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3.4.3 CALCUL DES NDVI ET IMAGE DE CHANGEMENTS 

Ce dernier volet de l’étape 1 consiste à synthétiser les informations contenues dans les deux images 

satellitaires d’origine. Il résulte une image de changements. 

3.4.3.1 CALCUL DE L’INDICE NDVI 

Le NDVI est calculé d’après l’équation 9 (page 12). Il s’agit d’un indice normalisé dont les valeurs varient entre   

-1 et 1. Un NDVI proche de 1 traduit une végétation active, proche de 0 un sol nu et, en-dessous de 0 des zones 

humides ou des plans d’eau. 

Démarche Manipulation sous QGis 

 
1. Calcul du NDVI 

 
Dans QGis : 

• Ouvrir les images annee1_toa_rouge.tif  et annee1_toa_pir.tif  
 
Dans la barre des menus : 

• Cliquer sur Raster > Calculatrice Raster 
 
Dans la calculatrice Raster : 

• Saisir la formule NDVI suivante : 
 

(annee1_toa_pir@1 - annee1_toa_rouge@1)/ 
(annee1_toa_pir@1 + annee1_toa_rouge@1) 

 
• Nommer le fichier en sortie, par exemple : annee1_ndvi.tif  

 
Calculer de la même manière le NDVI de l’année suivante.  
 

3.4.3.2 CRÉATION DE L’IMAGE DES CHANGEMENTS 

L’image des changements est tout simplement la différence des NDVI aux deux dates. Le résultat est une image 

monochrome. Visuellement, les pixels qui tendent vers le blanc ou le noir traduisent des changements 

d’occupation du sol. Les teintes grisées correspondent plutôt à des éléments invariants dans le temps. 

Démarche Manipulation sous QGis 

 
1. Vérification des 

données d’entrée 

 
Sous QGis,  

• Vérifier la présence des fichiers suivants : 
o annee1_ndvi.tif 
o annee2_ndvi.tif 
o emprise_globale.tif 

 

 
2. Calcul de l’image 

de changements 

 
Dans la barre des menus : 

• Cliquer sur : Raster > Calculatrice Raster 
 
Dans la calculatrice Raster : 

• Saisir l’expression suivant : 
 

annee2_ndvi@1 – annee1_ndvi@1 
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• Dans le champ Bandes Raster 
o Sélectionner emprise_globale@1  puis, 
o Cliquer sur le bouton Emprise actuelle de la couche 

 

• Enregistrer le fichier sous diff_ndvi.tif  
 

 
3. Intégration du 

masque 

 
Dans la calculatrice Raster : 

• Saisir l’expression suivante : 
 

("emprise_globale@1" = 1) * "diff_ndvi@1" + 
("emprise_globale@1" = 0) * -3 

 

• Enregistrer le résultat sous diff_ndvi_mask.tif  
 
Cette expression peut se lire ainsi : 
« Si le masque de l’emprise vaut 1 alors je conserve les valeurs de la différence des NDVI, sinon 
j’affecte la valeur -3. »  
 
N.B. La valeur -3 , en dehors de l’intervalle de la différence des NDVI (compris entre -2 et 2), 
sert de nodata . 
 

 
4. Nettoyage de la 

base de données 
(facultatif) 

 
À l’issue de l’étape 1, seul le fichier diff_ndvi_mask.tif  sera nécessaire dans la suite des 
traitements. Il est possible de supprimer les fichiers listés ci-dessous : 

o annee1_toa_rouge.tif 
o annee1_toa_pir.tif  
o annee2_toa_rouge.tif 
o annee2_toa_pir.tif 
o annee1_ndvi.tif 
o annee2_ndvi.tif 
o emprise_globale.tif 

 

 
5. Remarque 

 
Si les traitements portent sur des images Landsat ou toute autre image acquise en dehors du 
programme Geosud, il faut s’assurer que la projection est bien en Lambert 93. Autrement, il 
faut impérativement changer la projection du fichier diff_ndvi_mask.tif  avant de passer 
aux étapes 2 et 3. 
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3.5 ÉTAPES 2 & 3 : PRÉPARATION ET INTÉGRATION DES MASQUES 

 

La seconde étape consiste à masquer les pixels situés en dehors de la zone d’étude et des zones boisées. En 

entrée, les couches vectorielles sont converties en rasters binaires puis fusionnées. Le masque résultant est 

alors intégré à l’image des changements (la différence des NDVI produite à l’étape 1). Cette étape est 

obligatoire car la détection des coupes rases se fonde sur les statistiques de la distribution des pixels inclus 

dans les zones boisées uniquement. 

3.5.1 CRÉATION ET FUSION DES MASQUES 

Les fichiers vectoriels sont convertis en raster binaire afin d’optimiser les temps de calcul.  

3.5.1.1 CRÉATION DU MASQUE DE LA ZONE D’ÉTUDE 

La présente méthode se base sur les limites des sylvo-écorégions. Cependant, il est tout à fait possible 

d’intégrer d’autres délimitations, territoriales ou écologiques. 

Démarche Manipulation sous QGis 

 
1. Préparation de la 

couche vectorielle 

 
Sous QGis,  

• Ouvrir la couche vectorielle de la zone d’étude (ici sylvo_ecoregion.shp ) 
 
Dans la table attributaire : 

• Activer le mode d’édition en cliquant sur le bouton  

• Ouvrir la calculatrice de champs en cliquant sur  

• Dans la calculatrice de champ : 
o Créer un nouveau champ en le nommant ‘RASTER’  
o Choisir le type Nombre entier  avec, 
o Une longueur égale à 1 

• Dans le champ Expression : 
o Saisir 1 

• Cliquer sur OK 

• Désactiver le mode d’édition en cliquant de nouveau sur  
 

 
2. Conversion Raster 

de la zone d’étude 

 
Dans la barre des menus : 

• Cliquer sur Raster > Conversion > Rastériser (vecteur vers raster) 
 
Dans la fenêtre Rastériser : 

• Choisir le fichier source (shapefile) : sylvo_ecoregion 
• Choisir le Champ d’attribut : RASTER 
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• Enregistrer le fichier de sortie sous zone_etude.tif  

• Cliquer sur Résolution exprimée en unités de la carte par pixel et, 

• Saisir la valeur 5 pour les champs Horizontal et Vertical. 
 
Le fichier en sortie est un raster binaire, codé 1 pour tout pixel situé dans la zone d’étude, 0 
pour tout pixel situé en dehors. 
 

3.5.1.2 CRÉATION DU MASQUE FORÊT 

Le masque Forêt est réalisé à partir soit de la BD Topo® IGN (couche végétation), soit de la BD Forêt® IGN. Ces 

données vectorielles étant livrées par département, il est parfois nécessaire de fusionner ces informations pour 

couvrir la zone d’étude. Dans ce cas, il est conseillé de convertir chaque couche végétation en raster puis de les 

assembler dans une mosaïque. Cette approche est moins coûteuse en termes de temps de calcul. 

Démarche Manipulation sous QGis 

 
1. Préparation de la 

couche vectorielle 

 
Sous QGis,  

• Ouvrir la couche vectorielle de la BD Topo Végétation (ici vegetation_ign.shp ) 
 
Dans la table attributaire : 

• Activer le mode d’édition en cliquant sur le bouton  

• Ouvrir la calculatrice de champs en cliquant sur  

• Dans la calculatrice de champ : 
o Créer un nouveau champ en le nommant ‘RASTER’  
o Choisir le type Nombre entier  avec, 
o Une longueur égale à 1 

• Dans le champ Expression : 
o Saisir 1 

• Cliquer sur OK 

• Désactiver le mode d’édition en cliquant de nouveau sur  
 
N.B. Dans le cas d’une utilisation de la BD Forêt®, il faut supprimer les entités relatives aux 
landes et aux formations herbacées. 
 

 
2. Récupération des 

coordonnées de 
l’emprise de la 
zone d’étude 

 
L’objectif est de convertir la couche Végétation en un raster qui dispose des mêmes dimensions 
(étendue, nombre de pixels)  que le raster de la zone d’étude. 
 
Dans la liste des couches : 

• Double-cliquer sur zone_etude.tif , la fenêtre des propriétés de la couche 
s’affiche. 

 
Dans la fenêtre des propriétés de la couche : 

• Cliquer sur l’onglet Métadonnées  
o Dans le champ Propriétés : 

� Se positionner sur Dimensions et rechercher la taille (pixels) en 
lignes et en colonnes. 
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� Se positionner sur Emprise de la couche et copier les 

coordonnées. 
 

 
 

• Coller les coordonnées dans un bloc-notes par exemple et,  
o remplacer les caractères ‘, ’ (virgule) et ‘: ’ (deux-points) par un espace. 
o Insérer la commande ‘-te ’ au début de la ligne 

 

 
 

 
3. Conversion en 

raster 

 
Dans la barre des menus : 

• Cliquer sur Raster > Conversion > Rastériser (vecteur vers raster) 
 
Dans la fenêtre Rastériser : 

• Choisir le fichier source (shapefile) : vegetation_ign 
• Choisir le Champ d’attribut : RASTER 
• Enregistrer le fichier de sortie sous vegetation.tif  

• Cliquer sur Taille en pixel et, 

• Saisir les dimensions X (largeur) et Y (hauteur) obtenues précédemment. 

• Cliquer sur le bouton Éditer pour modifier la ligne de commandes Gdal et, 

• Copier/coller la ligne du bloc-notes juste après gdal_rasterize (cf. surbrillance dans la 
figure-ci-dessous) 
 

 
 

• Cliquer sur le bouton OK 
 

Le fichier en sortie est un raster binaire, codé 1 pour tout pixel attribué aux espaces boisés, 0 
pour tout pixel situé en dehors. 
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Exemple de conversion raster  
Résolution = 2 Résolution = 1 

  
 

 
N.B. Concernant la conversion en raster proposée par défaut dans QGis/Gdal, les pixels sont 
codés 1 car leur centre est situé à l’intérieur des polygones (cf. Figure ci-dessus). Si cette 
condition n’est pas vérifiée, ils sont codés 0. Ainsi, il est préférable de choisir une résolution 
spatiale suffisamment fine pour conserver le dessin des entités. La précision planimétrique de la 
couche végétation étant de 5m (cf. table attributaire), la conversion se cale sur cette échelle. 
 

 
4. Assemblage des 

fichiers raster 
Végétation 
(facultatif) 

 
Dans la barre des menus,  

• Cliquer sur : Raster > Calculatrice Raster 

• Saisir l’expression suivante (exemple pour deux rasters Végétation) : 
 

"vegetation_dptX@1" + "vegetation_dptY@1" > 0  

Où dptX  et dptY  correpondent aux numéros des départements traités 
 

• Nommer le fichier en sortie, par exemple : vegetation_mosa.tif 
 

3.5.1.3 FUSION DES MASQUES 

Les masques, une fois créés, sont fusionnés avant d’être appliqués à l’image des changements. 

Démarche Manipulation sous QGis 

 
1. Fusion des 

masques 

 
Dans la barre des menus : 

• Cliquer sur Raster > Calculatrice Raster 

• Saisir l’expression suivante : 
 
Si une seule couche végétation est exploitée : 

"zone_etude@1" + "vegetation@1" = 2  

 
Si plusieurs couches végétation sont exploitées : 

"zone_etude@1" + "vegetation_mosa@1" = 2  

 

• Cliquer sur Étendue actuelle de la couche en sélectionnant au préalable la bande 
zone_etude@1  

• Nommer le fichier en sortie, par exemple : masque_final.tif 
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3.5.2 INTÉGRATION DU MASQUE FINAL 

Une fois le masque créé, celui-ci est surimposé à l’image des changements. 

Démarche Manipulation sous QGis 

 
1. Vérification des 

données d’entrée 

 
Sous QGis,  

• Vérifier la présence des fichiers suivants : 
o diff_ndvi_mask.tif  
o masque_final.tif  

 

 
2. Intégration du 

masque 

 
Dans la barre des menus : 

• Cliquer sur Raster > Calculatrice Raster 

• Saisir l’expression suivante : 
 

("masque_final@1" = 1) * "diff_ndvi_mask@1" + 
("masque_final@1" = 0) * -3  

 

• Dans le champ Bandes Raster 
o Sélectionner masque_final@1  puis, 

• Cliquer sur le bouton Emprise actuelle de la couche 

• Nommer le fichier en sortie, par exemple : diff_ndvi_mask_vgt.tif 
 

 
3. Spécification de la 

valeur nodata 

 
A ce stade, l’image est prête. Toutefois la valeur -3  affectée aux pixels non valides n’est pas 
enregistrée dans l’entête du fichier image. Ce qui fausse les statistiques de l’image. 
 
Dans la barre des menus : 

• Cliquer sur Raster > Projection > 
Reprojection 

 
Dans la fenêtre Convertir : 

• Choisir le Fichier source 
diff_ndvi_mask_vgt.tif 

• Nommer le Fichier en sortie 
diff_ndvi_mask_final.tif 

• Cocher l’option Données sans 
valeurs et, 

o Saisir la valeur -3 
• Cliquer sur le bouton OK 

 
 
 
 
 
 
 
 
 

 
4. Vérification des 

statistiques 

 
Dans la liste des couches : 

• Double-cliquer sur diff_ndvi_mask_final.tif , la fenêtre des propriétés de la 
couche s’affiche. 
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Dans la fenêtre des propriétés de la couche : 

• Cliquer sur l’onglet Métadonnées  
o Dans le champ Propriétés : 

� Se positionner sur Bande 1. 
 

 
 

� Vérifier que les valeurs minimum et maximum se situent dans 
l’intervalle [-2,2] 

� Se positionner sur Aucune valeur de données 
 

 
 

� Vérifier que la valeur nodata est bien -3  
 

 
5. Nettoyage de la 

base de données 
(facultatif) 

 
À l’issue des étapes 2 et 3, seul le fichier diff_ndvi_mask_final.tif  sera nécessaire 
dans la suite des traitements. Les masques de la zone d’étude et de la végétation 
(masque_final.tif ) peuvent être appelés dans l’étape finale de qualification. Il est donc 
possible de supprimer les fichiers listés ci-dessous : 

o zone_etude.tif  
o vegetation.tif et/ou vegetation_mosa.tif  
o diff_ndvi_mask.tif  
o diff_ndvi_mask_vgt.tif  
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3.6 ÉTAPE 4 : DÉTECTION DES COUPES RASES 

 

L’image des changements issue de la différence des NDVI permet d’identifier les zones invariantes ainsi que les 

changements affectant l’occupation du sol entre deux dates. Les coupes rases correspondent à un changement 

dans une direction donnée, soit le passage d’un état végétalisé à un état non végétalisé. Pour extraire cette 

information, il faut définir l’intervalle de valeurs, autrement dit appliquer un seuillage sur l’image des 

changements.  

3.6.1 SEUILLAGE UNIQUE 

Les seuils peuvent être déterminés visuellement ou bien automatiquement en se basant sur les statistiques de 

l’image (sans tenir compte des pixels masqués). En effet, Le NDVI de la date 1 étant soustrait au NDVI de la 

date 2, les coupes rases ont par déduction des valeurs proche du minimum.  

 Démarche Manipulation sous QGis 

 
1. Récupération des 

statistiques de 
l’image des 
changements 

 
Dans la liste des couches : 

• Double-cliquer sur le raster diff_ndvi_mask_final.tif , la fenêtre des 
propriétés de la couche s’affiche. 

 
Dans la fenêtre des Propriétés : 

• Cliquer sur l’onglet Métadonnées ,  
o Dans le champ Propriétés : 

� Se positionner sur Bande 1. 
� Noter les valeurs de la moyenne m et de l’écart-type σ. 

 

 
 
Si les statistiques ne sont pas visibles,  

• Cliquer sur Raster > Divers > Information 
 
Dans la fenêtre Info 

• Indiquer le fichier source et cliquer sur OK,  

• les métadonnées stockées dans l’image apparaissent. 
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2. Identification des 

coupes rases par 
seuillage 

 
La moyenne et l’écart-type permettent de définir les seuils de détection des coupes rases : 
 

• La requête 1 est exprimée ainsi : TUVWêYU1 = [−2 < OBPQR < (] − ^)] 
 

Calcul de la requête n°1 : 
Dans la barre des menus,  

• Cliquer sur : Raster > Calculatrice Raster 

• Saisir la formule suivante : 
 

"diff_ndvi_mask_final@1" >= -2 AND  
"diff_ndvi_mask_final@1" < (m – σ) 

Remplacer m et σ par les valeurs trouvées dans les métadonnées. 
 

• Nommer le fichier en sortie, par exemple : seuil1.tif  
 
N.B. le résultat de cette requête est une image binaire codée 0 ou 1. Les pixels égaux à 1 
répondent à la requête (il s’agit donc des coupes rases). 
 

3.6.2 DISCRÉTISATION DES COUPES RASES DÉTECTÉES 

La détection des coupes rases, présentée ci-dessus, est une image binaire qui ne permet pas d’analyser plus 

finement les résultats obtenus. Or, il peut être intéressant d’associer aux pixels positifs, par exemple, un degré 

de certitude. 

Démarche Manipulation sous QGis 

 
1. Classification des 

coupes rases 

 
Récupérer les statistiques (moyenne et écart-type) de l’image de changement 
 
Le degré de certitude attribué aux coupes rases détectées est calculé comme suit : 
 

• Coupes avec degré de certitude faible 
,UaTé	1 = [(] − 2 ∗ ^) ≤ OBPQR < (] − ^)] 

 

• Coupes avec degré de certitude moyen 
,UaTé	2 = [(] − 3 ∗ ^) ≤ OBPQR < (] − 2 ∗ ^)] 

 

• Coupes avec degré de certitude fort 
,UaTé	3 = [−2 ≤ OBPQR < (] − 3 ∗ ^)] 

 

 
2. Identification des 

coupes rases avec 
un degré de 
certitude 

 
Dans la barre des menus,  

• Cliquer sur : Raster > Calculatrice Raster 

• Saisir la formule suivante : 
 

("diff_ndvi_mask_final@1" >= -2 AND  
"diff_ndvi_mask_final@1" < (m – 3 * σ)) * 3 +  
("diff_ndvi_mask_final@1" >= (m – 3 * σ) AND  

"diff_ndvi_mask_final@1" < (m – 2 * σ)) * 2 + 
("diff_ndvi_mask_final@1" >= (m – 2 * σ) AND  

"diff_ndvi_mask_final@1" < (m - σ)) 

Remplacer m et σ par les valeurs trouvées dans les métadonnées. 
 

• Nommer le fichier en sortie, par exemple : seuil_degre.tif  
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Le résultat est un raster dont les valeurs de pixel sont comprises entre 0 et 3. 
 

• 0 = absence de coupes rases 

• 1 = coupes avec degré de certitude faible 

• 2 = coupes avec degré de certitude moyen 
• 3 = coupes avec degré de certitude fort 

 

 

 

  
 

3.6.3 FILTRAGE 

À l’issue du seuillage, un raster binaire est créé. Les valeurs codées 1, 2 ou 3 identifient les coupes rases. 

Toutefois, cette donnée comporte des groupes de pixels dont la superficie est en deçà des spécifications, voire 

des pixels isolés. Un filtre est donc appliqué pour éliminer ces artéfacts et réduire le nombre d’entités lors de 

l’export en mode vectoriel. 

Démarche Manipulation sous QGis 

 
1. Post-traitements 

 
Le filtre GDAL Sieve (Tamiser sous QGis) est appliqué sur les images binaires. Cet outil élimine les 
objets raster dont la surface (en pixels) est inférieure au seuil spécifié par l’opérateur en 
remplaçant leur valeur par celle de l’objet voisin le plus grand. Outre sa taille, un objet raster est 
également défini en fonction de sa connectivité qui exprime la relation d’un pixel avec ses 
voisins. Celle-ci tient compte ou non des pixels en diagonale, elle aura respectivement une valeur 
de 8 ou de 4. Ce qui impactera la forme finale des objets suite au filtrage (cf. Figure ci-dessous). 
 

 

  4 connexions   

   

 

 
  8 connexions   

 
 

 

 

 
Résultat de requête 
en blanc : les coupes,  
en noir : la forêt 

 Filtre Sieve : 
détection des objets 
à éliminer (en rouge) 
(seuil = 3 pixels)  

 Filtre Sieve : 
reclassement des 
objets 

 
Dans la barre de menus 

• Cliquer sur Raster > Analyse > Tamiser 
 
Dans la fenêtre Tamiser : 

• Indiquer le fichier source, par exemple : seuil_degre.tif  

• Nommer le fichier en sortie, par exemple : seuil_degre_lisse.tif  

• Saisir un seuil : 200 
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N.B. À définir en fonction de la résolution de l’image et de la taille minimale 
recherchée pour les coupes, dans cet exemple la résolution est de 5 m et la taille 
minimale des coupes est de 0.5ha, soit 200 pixels. 

 

• Indiquer le nombre de connexions de pixel : 4 
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3.7 ÉTAPE 5 : CONVERSION VECTORIELLE 

 

Le fichier des coupes rases détectées est enfin exporté en vecteur. La table attributaire est mise à jour afin 

d’ajouter la superficie des polygones et, éventuellement les fausses détections dues à la présence de nuages 

sur les images satellitaires. 

3.7.1 EXPORT VECTORIEL 

La conversion du raster en vecteur fait appel à la bibliothèque Gdal, installé par défaut sur QGis. Cependant 

L’algorithme proposé n’est pas très performant en termes de temps de traitement. Si possible, préférer 

d’autres outils tels que Grass (commande r.to.vect). 

Démarche Manipulation sous QGis 

 
1. Export des coupes 

en mode vecteur 

 
Dans la barre des menus  

• Cliquer sur Raster > Conversion > Polygoniser (Raster vers Vecteur) 
 
Dans la fenêtre Polygoniser (Raster vers Vecteur) : 

• Indiquer le fichier source (raster) : seuil_degre_lisse.tif 
• Nommer le fichier en sortie, par exemple : seuil_degre_lisse.shp 
• Cocher Nom du champ : DN 

• Cocher Utiliser le masque et sélectionner : seuil_degre_lisse.tif  
N.B. Cette option permet de ne pas vectoriser les pixels nuls. 

• Cliquer sur OK 
 

 
 
En sortie, la couche contient des polygones. Dans le champ ‘DN’ de la table attributaire, les 
coupes rases sont codées en entiers de 1 à 3. 
 

 
2. Vérification 

visuelle 

 
Ouvrir les images satellitaires de l’année 2 ainsi que le(s) shapefile(s) créé(s) précédemment 
(par exemple seuil_degre_lisse.shp ). 
 
Vérifier visuellement la concordance entre les polygones et les coupes rases visibles sur l’image. 
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3.7.2 MISE À JOUR DE LA TABLE ATTRIBUTAIRE 

La table attributaire est enrichie d’un nouveau champ : la superficie (en Ha). Ces informations permettent de 

filtrer la couche vectorielle et, de procéder à des analyses. 

Démarche Manipulation sous QGis 

 
1. Calcul des 

surfaces des 
polygones 

 
Ouvrir la table attributaire du vecteur seuil_degre_lisse.shp  
 
Dans la table attributaire,  

• Ouvrir la calculatrice de champs en cliquant sur  
 
Dans la calculatrice de champ : 
 

• Cocher Créer un nouveau champ 

• Indiquer le Nom du champ, par 
exemple : Surface  

• Définir le Type : Nombre 
décimal (réel) 

• Indiquer une Précision = 3 
(nombre de chiffres derrière la 
virgule) 

• Dans la liste des fonctions, se 
positionner sur Géométrie et 
double-cliquer sur $area 

• L’aire est par défaut calculée dans le système de mesure de la projection, ici le mètre. 
Dans le champ Expression, ajouter /10000  pour obtenir un résultat en hectares. 

• Cliquer sur OK 
 

 
2. Sélection des 

entités 
supérieures à la 
surface minimale 
de détection des 
coupes 

 
Dans la liste des couches,  

• Cliquer-droit sur la couche seuil_degre_lisse.shp  et,  

• Sélectionner Requête… 
 
Dans la fenêtre Constructeur de requête : 

• Double-cliquer sur le champ Surface  recensant les superficies des entités de  
seuil_degre_lisse.shp , 

• Dans le champ de clause SQL WHERE, ajouter > 0.5  (surface minimale souhaitée ici) 

• Cliquer sur OK 
 

 
 

Les polygones dont la surface est supérieure à 0.5ha sont sélectionnés. 
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Dans la liste des couches,  

• Cliquer-droit sur la couche seuil_degre_lisse.shp  et,  

• Sélectionner Sauvegarder la sélection sous… 

• Nommer le fichier coupes_sup05Ha.shp  
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3.8 ETAPE 6 : SUPERPOSITION DES COUCHES VECTORIELLES (FACULTATIF) 

 

Les fichiers vectoriels, issus de la détection des coupes rases sur différentes images, sont assemblés à l’aide 

d’une union géométrique. Lorsque les entités se superposent, les degrés de certitude associés nécessitent 

d’être recalculés.  

3.8.1 FUSION DES VECTEURS 

Afin de simplifier l’analyse des coupes rases détectées, les vecteurs peuvent être fusionnés dans un fichier 

unique. Les outils d’union géométrique proposés dans QGis ne fournissent pas les mêmes résultats. Pour cette 

étape, Grass est donc préféré. 

Démarche Manipulation sous QGis 

 
1. Activation des 

outils Grass 

 
Dans la barre des menus, cliquer sur Extension > Installer/Gérer les extensions  
 
Dans la fenêtre Extensions : 
 

• Cliquer sur l’onglet Toutes 
o Dans le champ Rechercher, saisir processing ,  
o Sélectionner l’extension Processing  et, 

• Cliquer sur Fermer 
 
N.B. L’extension Processing est normalement installée par défaut. Il faut juste l’activer. 
 
Dans la barre des menus,  

• Cliquer sur : Traitements > Boîte à outils 
 
La fenêtre Boîte à outils de traitements apparaît à droite de l’écran. 
 

 
2. Union 

géométrique des 
couches 
vectorielles sous 
Grass 

 
Soit deux couches vectorielles de détection des coupes rases issues de deux images satellitaires 
(A et B) se chevauchant, et comportant chacune un champ ‘DN’ (degré de certitude) : 
 

• Coupes_sup05Ha_A.shp  
• Coupes_sup05Ha_B.shp  

 
Dans la fenêtre Boîte à outils de traitements : 

• Cliquer sur GRASS commands > Vector > v.overlay – Overlays two vector maps. 
 
Dans la fenêtre v.overlay, saisir les paramètres suivants : 

• Input layer (A) : Coupes_sup05Ha_A.shp  

• Input layer (A) Type : area  

• Input layer (B) : Coupes_sup05Ha_B.shp  

• Operator to use : or  

• Do not create attribute table : No 

• Overlay : Coupes_union.shp  
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N.B. L’outil de géotraitements Union proposé par QGis est déconseillé car les polygones 
intersectés sont dupliqués n+1 fois, où n représente le nombre de polygones superposés en 
entrée. 
 
En sortie, la couche Coupes_union.shp  contient au minimum deux champs a_DN et b_DN, 
issus respectivement des couches Coupes_sup05Ha_A.shp  et 
Coupes_sup05Ha_B.shp . 

 

3.8.2 MISE À JOUR DES DEGRÉS DE CERTITUDE SUR LES ZONES DE RECOUVREMENT 

Suite à une union, les entités intersectées récupèrent deux degrés de certitude. Il faut donc recalculer cet 

indicateur. Deux méthodes sont proposées : la moyenne et la concaténation. 

Démarche Manipulation sous QGis 

 
1. Création d’un 

champ et calcul du 
degré de certitude 
- moyenne 

 
Ouvrir la table attributaire de Coupes_union.shp  
 
Dans la table attributaire : 

• Activer le mode édition en cliquant sur  

• Ouvrir la calculatrice de champs en cliquant sur  

• Cocher Créer un nouveau champ 

• Indiquer le Nom du champ, par exemple : degre_moy  

• Définir le Type : Nombre décimal (réel) 
• Saisir une Précision égale à 1 
• Entrer l’expression : 

 
CASE WHEN "a_DN" IS NULL THEN "b_DN" 

WHEN "b_DN" IS NULL THEN "a_DN" 
ELSE ( "a_DN" + "b_DN" ) / 2.0 

END 

 

• Cliquer sur OK 

• Fermer le mode édition et sauvegarder 
 
Le champ degre_moy  contient des nombres réels compris entre 1 et 3. Plus cette valeur est 
élevée, plus la certitude de détection est forte. 

 
 

2. Création d’un 
champ et calcul du 
degré de certitude 
- concaténation 

 
Ouvrir la table attributaire de Coupes_union.shp  
 
Dans la table attributaire : 

• Activer le mode édition en cliquant sur  

• Ouvrir la calculatrice de champs en cliquant sur  

• Cocher Créer un nouveau champ 

• Indiquer le Nom du champ, par exemple : degre_conc  

• Définir le Type : Texte (chaîne de caractères) 
• Saisir une Longueur égale à 2 
• Entrer l’expression : 

 
CASE WHEN "a_DN" IS NULL THEN ( '0' || tostring( "b _DN" )) 

WHEN "b_DN" IS NULL THEN ( tostring( "a_DN" ) || '0 ' ) 
ELSE tostring( "a_DN" || "b_DN" ) 

END 
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• Cliquer sur OK 

• Fermer le mode édition et sauvegarder 
 
Le champ degre_conc  contient des chaînes de caractères xy , où x  représente le degré de 
certitude du champ a_DN et y  celui du champ b_DN. Si x  ou y  est nul, alors il n’y a pas de 
superposition entre les polygones des couches en entrée. 
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3.9 ÉTAPE 7 : ÉVALUATION DE LA QUALITÉ SÉMANTIQUE 

 

La qualité sémantique d’une classification est mesurée, le plus souvent, à l’aide d’une matrice de confusion. Ce 

tableau de contingence permet de comparer la classification avec des données de référence. Idéalement, les 

données de référence sont collectées sur le terrain. Toutefois, elles peuvent être aussi acquises par photo-

interprétation sur les images satellitaires traitées. 

3.9.1 CRÉATION D’UNE RÉFÉRENCE PAR PHOTO-INTERPRÉTATION 

La collecte des données de référence par photo-interprétation n’est pas obligatoire. Néanmoins, cette étape 

est utile pour évaluer le résultat et, corriger la cartographie des coupes avant toute intervention sur le terrain. 

La référence, établie ici à partir du fichier vectoriel des coupes rases détectées, ne permet pas de mesurer 

l’erreur d’omission (coupes non détectées). La matrice de confusion restitue donc une évaluation de la 

précision utilisateur et de l’erreur de commission. 

Démarche Manipulation sous QGis 

 
1. Affichage et 

préparation des 
images 

 
Trois images sont nécessaires : les images satellitaires correspondant aux deux dates comparées 
ainsi que le masque Forêt. En effet, lors de la photo-interprétation, il faut saisir des parcelles, 
situées dans la couche végétation de la BD Topo® IGN (ou BD Forêt® IGN), qui sont passées d’un 
état arboré à un état sol nu. 
  
Sous QGis : 

• Ouvrir les images multi-spectrales des années 1 et 2 

• Choisir une composition colorée « proche infrarouge » ou « couleurs naturelles » et, 

• Gérer les contrastes. 

• Ouvrir le masque Forêt (masque_final.tif ) et, 

• Définir la symbologie comme suit : 
o Dans les propriétés du masque Forêt : 
o Cliquer sur l’onglet Style 
o Choisir le type de rendu Pseudo-couleur à bande unique  
o Sélectionner une interpolation des couleurs Exact  
o Insérer la valeur 0 et, 
o Choisir une couleur neutre (par exemple le gris) 
o Cliquer sur les boutons Appliquer et OK 
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2. Création d’un 

fichier vectoriel de 
référence 

 
Cette étape consiste à réaliser une sélection aléatoire et stratifiée sur la couche vectorielle des 
coupes rases détectées et ce, en fonction du champ ‘DN’. Par défaut, 100 polygones par type 
sont sélectionnés, ce qui assure un équilibre entre la représentativité statistique et le temps de 
photo-interprétation. Ceci dit, la littérature scientifique recommande au minimum 50 points de 
contrôle.  
 
Sous QGis : 

• Ouvrir le fichier vecteur des coupes rases détectées Coupes_sup05Ha.shp 
 
Dans la barre des menus : 

• cliquer sur Vecteur > Outils de recherche > Sélection aléatoire dans les sous-parties 
 
Dans la fenêtre Sélection aléatoire dans les sous-parties : 

• Indiquer la Couche vectorielle en entrée : Coupes_sup05Ha.shp 
• Choisir le Champ de saisie de sous-ensemble : DN 
• Cocher l’option Nombre d’entités et saisir la valeur 100 
• Cliquer sur le bouton OK 

 
Dans la liste des couches : 

• Cliquer-droit sur le vecteur des coupes rases détectées Coupes_sup05Ha.shp  et, 

• Sélectionner Sauvegarder la sélection sous … 

• Enregistrer le fichier sous le nom reference.shp  
 
Fermer la couche Coupes_sup05Ha.shp  et, 
Ouvrir le fichier vectoriel reference.shp 
 
Dans la liste des couches : 

• Cliquer-droit sur reference.shp  et sélectionner Propriétés 
Dans la fenêtre Propriétés de la couche : 

• Cliquer sur l’onglet Champs 

• Cliquer sur le bouton Basculer en mode d’édition   

• Cliquer sur le bouton Nouvelle colonne  et configurer comme suit : 
o Nom : reference  
o Type : Nombre entier  
o Largeur : 1 

• Fermer le mode édition en cliquant de nouveau sur le bouton et, Enregistrer. 

• Pour tous les champs attributaires, excepté le champ reference , cliquer sur le 
bouton Edition de ligne et décocher le mode Editable 

• Pour le champ reference , cliquer sur le bouton Edition de ligne 

• Dans le dialogue d’édition d’attribut « reference » : 

• Choisir Liste de valeurs , une table avec deux colonnes apparaît 

• Saisir les valeurs 0 et 1, avec en description erreur  (absence de coupes), et 
coupes observées  
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3. Configuration des 

outils 
cartographiques 

 
Les étapes 3 et 4 sont facultatives. Elles proposent une configuration de QGis pour renseigner 
plus aisément la table attributaire de la couche de référence. 
 
Dans la barre des menus : 

• Cliquer sur Préférences > Options… 
Dans la fenêtre Options : 

• Cliquer sur l’onglet Style 

• Choisir le type de symbole : Bordure : Ligne simple  

• Cliquer sur l’onglet Outils cartographiques 

• Cocher l’option Ouvrir le formulaire si une seule entité est identifiée 

• Cliquer sur l’onglet Numérisation 

• Dans le champ Symbole de sommet, cocher l’option Montrer les symboles 
uniquement pour les entités sélectionnées 

• Cliquer sur le bouton OK 
 

 
4. Photo-

interprétation 

 
Organisation des fenêtres de travail à l’écran : 

• Ouvrir la table attributaire du fichier reference.shp . 

• Positionner la table attributaire à gauche de l’écran, l’interface cartographique à 
droite. 

 

 
 

Dans la table attributaire (à gauche) : 

• Basculer en mode édition en cliquant sur le bouton  

• Cliquer sur la première ligne de la table attributaire puis, 

• Cliquer soit sur le bouton  (Déplacer la carte sur les lignes sélectionnées), soit sur 

le bouton  (Zoomer la carte sur les lignes sélectionnées) 
 
Dans l’interface cartographique (à droite) : 

• Cliquer sur le bouton  (identifier 
les entités) et, 

• Cliquer sur le polygone sélectionné, 
un formulaire s’affiche. 

• Sélectionner la classe correspondant 
à la nature de la coupe observée. 

 
 
 
 
 
De la même manière, photo-interpréter tous les objets du vecteur reference.shp   en 
sauvegardant régulièrement. 
 
N.B. QGis propose une extension, Item Browser, dédiée à la mise à jour des entités vectorielles. 
Cet outil permet de se positionner automatiquement sur l’entité ciblée et d’accéder aux champs 
éditables via un formulaire. Toutefois, il n’est pas possible d’afficher les objets sélectionnés avec 
un fond transparent. 
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3.9.2 CONSTRUCTION DE LA MATRICE DE CONFUSION 

Bien que certains outils de QGis permettent de produire automatiquement la matrice de confusion, la 

procédure est décrite ici à l’aide d’un tableur afin de bien comprendre la construction de ce tableau et la 

signification des précisions et erreurs associées. 

Démarche Manipulation sous QGis 

 
1. Construction de la 

matrice de 
confusion 

 
Ouvrir un tableur (par exemple LibreOffice Calc) 
 
Sous LibreOfficeCalc : 

• Ouvrir la table attributaire (fichier avec extension .dbf) de reference.shp  

• Enregistrer la table au format .ods 

• Cliquer sur Données > Table de pilote > Créer… 

• Conserver la sélection active et cliquer sur OK 
 

• Dans la fenêtre du Pilote de données, insérer dans : 
o Champs de colonne : la colonne DN (détection effective des coupes rases) 

N.B. Pour cet exemple, seuls les degrés 2 et 3 sont conservés et associés à la 
valeur 1 (coupes observées) de la référence. 

o Champs de ligne : la colonne reference  (vérification par photo-
interprétation) 

o Champs de données : la colonne reference  (Options… > Nombre) 
 

 
 

 
2. Calcul des 

indicateurs de 
précision et 
d’erreur 

 
Copier/coller la table résultante dans une nouvelle feuille afin d’y apporter certaines 
modifications (cf. § 2.4, page 15). 
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Les précisions et erreurs sont calculées de la façon suivante : 
 

• Précision globale 

o C11 = 100*(C5+D6)/E7 

• Précision utilisateur • Erreur de commission 

o C8 = 100*C5/C7 o C9 = 100-C8 
o D8 = 100*D6/D7 o D9 = 100-D8 

• Précision producteur • Erreur d’omission 

o F5 = 100*C5/E5 o G5 = 100-F5 
o F6 = 100*D6/E6 o G6 = 100-F6 

  
N.B. De la même manière, la matrice de confusion peut être calculée en fonction des superficies. 
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5 ANNEXES 

5.1 GLOSSAIRE DES TERMES TECHNIQUES 

Angle zénithal solaire : angle entre la droite du soleil et la verticale par rapport à un point situé sur la surface 

terrestre, complémentaire de l’angle d’élévation solaire. 
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Bande spectrale : canal d’une image correspondant à un intervalle de longueurs d’onde dans le spectre 

électromagnétique. Par exemple, RapidEye a cinq bandes spectrales : le bleu, le vert, le rouge, le rededge 

et le proche infrarouge. 

Canal : un fichier image est parfois constitué de plusieurs canaux, retranscrivant chacun une information 

différente. Par exemple, une photographie numérique couleur dispose de trois canaux : le bleu, le vert et le 

rouge. Voir bande spectrale. 

Capteur : dispositif embarqué sur le satellite qui recueille et mesure le rayonnement incident provenant de la 

surface observée. 

Coefficient de calibration absolue : paramètre permettant de convertir les comptes numériques d’une image en 

énergie (luminance). 

Compte numérique : codage du pixel en bits traduisant la mesure du rayonnement enregistré et converti en 

signal électrique par le capteur. 

Indice de végétation : image monochromatique issue de la combinaison arithmétique des réflectances de deux 

bandes spectrales au moins permettant d’identifier les propriétés particulières de la végétation. Par 

exemple, le NDVI résulte d’une différence entre le proche infrarouge et le rouge. 

Luminance : quantité d’énergie (intensité), par unité de surface et selon une direction donnée. Elle s’exprime en 

W.m
-2

.sr
-1

 (watt par mètre carré par stéradian). 

Multispectral : une image multispectrale est un enregistrement simultané du rayonnement réfléchi par la 

surface terrestre à des intervalles de longueurs d’onde spécifiques dans le spectre électromagnétique, 

notamment entre le visible et l’infrarouge. Chaque canal de l’image correspond donc à une longueur 

d’onde. Par exemple une image multispectrale SPOT 5 comporte 4 canaux : le vert (0.50~0.59µm), le rouge 

(0.61~0.68µm), le proche infrarouge (0.78~0.89µm) et le moyen infrarouge (1.58~1.75µm). 

NDVI : (Normalized Difference Vegetation Index), voir indice de végétation. 

Normalisation radiométrique relative : méthode statistique permettant de réduire sur les images satellitaires les 

effets de changement des conditions atmosphériques en l’absence d’accès aux paramètres 

atmosphériques. 
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Panchromatique : une image panchromatique est un enregistrement global du rayonnement réfléchi par la 

surface terrestre dans la gamme des longueurs d’onde du spectre visible sans séparation des couleurs. Par 

exemple, une image panchromatique SPOT 5 est acquise entre 0.48 et 0.71µm. Cette donnée est plus 

résolue spatialement que l’image multispectrale acquise par un même satellite. 

Prétraitement : technique d’amélioration d’images nécessaire avant l’analyse et l’extraction de l’information. Le 

prétraitement intègre généralement les corrections radiométriques et géométriques. 

Réflectance : proportion de lumière incidente (éclairement solaire) réfléchie par la surface terrestre. Elle 

s’exprime en pourcentage. 

Résolution radiométrique : décrit la capacité d’un capteur de distinguer de petites différences dans l’intensité 

de l’énergie reçue. Le nombre maximum de niveaux d’intensité dépend du nombre de bits utilisés. Par 

exemple, une image RapidEye est codée en 16 bits soit 65536 valeurs numériques disponibles pour 

retranscrire l'intensité enregistrée ; une image SPOT est codée en 8 bits soit 256 valeurs numériques. 

Résolution spatiale : taille des pixels (dans l’unité du système de projection) de l’image satellitaire, par exemple 

les images RapidEye et IRS ont respectivement une résolution spatiale de 5 et 20m. 

Résolution spectrale : décrit la finesse d’une bande spectrale utilisée par un capteur. Plus la résolution spectrale 

est fine, plus les fenêtres des différents canaux du capteur sont étroites. 

Spectre électromagnétique : séquence continue d’énergie électromagnétique conçue en fonction des longueurs 

d’onde ou des fréquences. 
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Télédétection : mesure ou acquisition d’informations sur un objet ou un phénomène, par l’intermédiaire d’un 

instrument de mesure à distance. La télédétection satellitaire intègre aussi les traitements numériques 

appliqués aux images. 
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5.2 MANIPULATIONS COMPLÉMENTAIRES SOUS QGIS 

Cette annexe recense des techniques fréquemment utilisées sous QGis pour manipuler plus aisément les 

images satellitaires. 

5.2.1 GESTION DU CONTRASTE DES IMAGES 

Par défaut, QGis affiche l’image sans améliorations des contrastes. L’image apparaît très sombre voire bruitée. 

Impossible de procéder à une interprétation visuelle dans ces conditions. 

L’adaptation de dynamique permet d’améliorer la lisibilité d’une image à l’écran sans affecter les valeurs 

numériques contenues dans le fichier. Elle applique une loi de transcodage (LUT = look-up table) pour passer 

des valeurs numériques d’un plan image aux valeurs numériques affichées à l’écran et ce, afin d’améliorer le 

contraste et l’intensité de l’image. Plusieurs méthodes sont proposées par QGis. 

Démarche Manipulation sous QGis 

 
1. Gestion 

automatique des 
contrastes en 
fonction des 
valeurs extrêmes 

 
Dans la barre d’outils 

• Cliquer sur Vue > Zoom sur l’étendue ou cliquer sur   
 

Dans la barre d’outils : 

• Cliquer sur  (Étendre l’histogramme à tout le jeu de données) 
 
Cet outil calcule les valeurs minimale et maximale des pixels sur l’ensemble de l’image et ce, 
pour chacune des bandes spectrales. Toutes les valeurs inférieures ou égales au minimum sont 
affichées à 0 (noir), toutes les valeurs supérieures ou égales au maximum sont affichées à 255 
(blanc). Les valeurs comprises entre le minimum et le maximum sont « étalées » entre 0 et 255. 
Généralement, le contraste obtenu est faible et ne permet pas de distinguer correctement les 
différents types d’occupation du sol. 
 

• Zoomer sur une partie de l’image et,  

• Cliquer sur  (Histogramme de l’étendue locale) 
 
Cet outil fonctionne de la même manière que le précédent, en tenant compte des valeurs 
minimales et maximales. Toutefois, ces valeurs sont cette fois-ci calculées dans l’emprise de la 
fenêtre de visualisation. 
 

 
2. Gestion manuelle 

des contrastes en 
fonction des 
valeurs extrêmes 

 
Afin de bien comprendre les contrastes opérés par les outils de gestion automatique, il est 
possible de reproduire « manuellement » les mêmes résultats que ceux obtenus dans l’étape 
précédente. 
 

1. Que fait  ? 
 
Dans la liste des couches 

• Cliquer-droit sur l’image et,  

• Sélectionner Propriétés 
 
Dans la fenêtre Propriétés de la couche,  

• Cliquer sur l’onglet Style  
o Dans la zone Charger les valeurs min/max 

� Cocher Min/max 
� Choisir l’emprise Complète 
� Choisir la précision Estimée 
� Cliquer ensuite sur le bouton Charger 
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o Dans le champ Amélioration de contraste 

� Sélectionner Étirer jusqu’au MinMax 

• Cliquer sur Appliquer et OK 
 

2. Que fait  ? 
 
Zoomer sur une partie de l’image présentant un très faible contraste (rendu quasi noir) 
 
Dans la liste des couches 

• Cliquer-droit sur l’image et,  

• Sélectionner Propriétés 
 
Dans la fenêtre Propriétés de la couche,  

• Cliquer sur l’onglet Style  
o Dans la zone Charger les valeurs min/max 

� Cocher Min/max 
� Choisir l’emprise Actuelle 
� Choisir la précision Estimée 
� Cliquer ensuite sur le bouton Charger 

o Dans le champ Amélioration de contraste 
� Sélectionner Étirer jusqu’au MinMax 

• Cliquer sur Appliquer et OK 
 

 
3. Gestion 

automatique des 
contrastes en 
excluant les 
valeurs extrêmes 

 
L’utilisation des valeurs extrêmes pour améliorer le contraste d’une image est souvent 
insatisfaisante. L’inconvénient étant qu’elle ne tient pas compte de la distribution des valeurs 
des pixels. 
 
Dans la barre d’outils 

• Cliquer sur Vue > Zoom sur l’étendue ou cliquer sur  
 

Dans la barre d’outils : 

• Cliquer sur   
 
Cet outil déduit les bornes d’étalement de la dynamique grâce à l’histogramme cumulé (taux de 
pixels ayant une valeur inférieure à un niveau d’intensité donné) calculé sur l’ensemble de 
l’image. Par défaut, il positionne la valeur minimale et la valeur maximale à 2% et 98% 
respectivement. 
 

• Zoomer sur une partie de l’image et,  

• Cliquer sur   
 
Cet outil fonctionne de la même manière que le précédent, en tenant compte uniquement de la 
distribution des valeurs de pixels dans l’emprise de la fenêtre de visualisation. 
 

  
Cette méthode de rehaussement est également reproductible manuellement dans les 
propriétés de la couche. Une dernière méthode, disponible sous QGis, utilise la moyenne et 
l’écart-type de l’image. 
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5.2.2 COMPOSITIONS COLORÉES 

Une composition colorée est la combinaison optique (synthèse additive) d’images multi-bande par projection 

de celles-ci au travers de filtres rouge, vert et bleu. Elle permet de produire une image en couleurs en tenant 

compte des signatures spectrales des objets observés. Ce mode de représentation met en en évidence certains 

types d’occupation du sol ou phénomènes environnementaux. Il est donc très utile pour contrôler visuellement 

les résultats de la méthode de détection des coupes rases. 

 

 

 

 

 

 

� � 

 

  

Il est possible d’afficher différentes compositions colorées, parmi les plus connues : 

• Composition en couleurs naturelles : 

o Filtre rouge :  bande rouge 
o Filtre vert : bande verte 
o Filtre bleu : bande bleue 

• Composition en couleurs infrarouges : 

o Filtre rouge :  bande proche infrarouge 
o Filtre vert : bande rouge 
o Filtre bleu : bande verte 

 

Démarche Manipulation sous QGis 

 
1. Affichage d’une 

composition 
colorée 

 
Dans la liste des couches 

• Cliquer-droit sur l’image et,  

• Sélectionner Propriétés 
 

Dans la fenêtre Propriétés de la couche 

• Cliquer sur l’onglet Style  
o Dans la zone Rendu par bande 

� Changer l’ordre des bandes spectrales de manière à afficher une 
composition « couleurs naturelles » puis une composition 
« couleurs infrarouges » 

o Gérer les contrastes (cf. §5.2.1) 

• Cliquer sur Appliquer et OK 
 

 
2. Configuration des 

options de rendu 

 
Pour simplifier la gestion de l’affichage des images satellitaires, il est possible de configurer une 
composition colorée par défaut ainsi que l’application d’un contraste. 
 
Dans la barre de menu,  

• Cliquer sur Préférences > Options… 
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Dans la fenêtre Options,  

• Cliquer sur l’onglet Rendu  
o Dans la zone Rasters 

� Affecter au Rouge, au Vert et au Bleu les bandes utiles pour une 
composition en couleurs naturelles ou infrarouge  
(par exemple pour RapidEye, la composition colorée infrarouge est 
la suivante : Rouge : bande 5, Vert : bande 3, Bleu : bande 2) 

� Sélectionner Étirer jusqu’au MinMax 
� Sélectionner, par exemple, le calcul des Limites (Minimum / 

Maximum) en Moyenne +/- écart-type   
� Saisir un Multiplicateur de l’écart-type égal à 2 

• Cliquer sur OK 
 

5.2.3 COMPRESSION DES IMAGES 

Les images satellitaires, souvent volumineuses, peuvent être compressées. Cette manipulation est 

recommandée pour des machines disposant d’un espace de stockage réduit. 

Démarche Manipulation sous QGis 

 
1. Configuration des 

options de 
compression 

 
Dans la barre de menu 

• Cliquer sur Préférences > Options… 
 
Dans la fenêtre Options 

• Cliquer sur l’onglet GDAL  
o Dans les Options des pilotes GDAL 

� Sélectionner le format GTiff et, 
� Cliquer sur le bouton Modifier les options de création 

o Dans la fenêtre Options de création – Pilote GTiff 
� Cliquer sur le bouton Nouveau 
� Saisir LZW comme nom de profil 

N.B. LZW est un algorithme de compression sans perte. 
� Cliquer sur le bouton + et insérer les options indiquées sur la 

figure ci-dessous : 
 

 
 

� Cliquer sur les boutons Valider et OK 

• Cliquer sur le bouton OK pour fermer la fenêtre des options 
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2. Exemple de 

compression 
d’une image 
satellitaire 

 
Dans la barre de menu 

• Cliquer sur Raster > Conversion > Convertir 
 
Dans la fenêtre Convertir 

• Sélectionner l’image en entrée 

• Choisir un nom de Fichier en sortie 

• Cocher Sans donnée et attribuer la valeur 0 (facultatif) 

• Cocher Options de création et 

• Sélectionner le profil LZW (créé précédemment) 
 

 
 

• Cliquer sur le bouton OK 
 
Cet exemple traite une image Landsat 8 avec 3 bandes spectrales. Le poids initial du fichier est 
de 357 Mo. Après compression, il passe à 299 Mo, soit un gain d’environ 16%. 
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5.3 PRÉSENTATION TETIS AU COPIL DU 23 AVRIL 2012 
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